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1.0   QUALITY ASSURANCE 
 

1.1 UNIT DESCRIPTION 
 
The Forensic Biology Unit is comprised of Criminalists, a DNA Technical Manager, a CODIS Administrator, a 
Laboratory Technician, and two Supervising Criminalists.  The unit is generally staffed from 0700-1700hrs 
Monday through Friday. 
 
The Forensic Biology laboratory is divided into three distinct areas on the 6th floor of the SDPD headquarters 
building:  the main laboratory area which is used for the purposes of screening items of evidence and the DNA 
extraction process; a room dedicated to PCR setup; and a separate area dedicated to the preparation and analysis 
of amplified DNA. 
 
1.2 UNIT FUNCTIONS 
 
The Forensic Biology Unit aims to provide analysis on all reasonable requests from any investigative units of the 
San Diego Police Department using the most current technologies available. 
 
The Forensic Biology Unit’s primary duties are to analyze items of physical evidence to locate and identify 
biological material, and perform DNA analysis on that biological material. 
 
The biological materials that the Unit can presumptively identify, or confirm the presence of, are blood, semen, 
saliva, and feces.  DNA analysis may be performed on all of these materials as well as hair, bone, and other body 
fluids or tissues. 
 
The DNA testing capabilities of the Forensic Biology Unit include both autosomal and Y-chromosome STR DNA 
testing. 
 
Additional duties performed by the Forensic Biology Unit include the validation and implementation of new 
technologies, courtroom testimony, and crime scene reconstruction. 
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1.3 PERSONNEL AND JOB DESCRIPTIONS 
 

1.3.1 SUPERVISING CRIMINALIST 
 

The Supervising Criminalist of the Forensic Biology Unit will oversee the Forensic Biology Unit and analysts.  
The responsibilities will include assigning casework, interacting with attorneys and detectives to determine 
case priorities, reviewing the work of all assigned analysts, and monitoring the overall job performance of 
analysts.  
 
Duties and responsibilities: (The duties of Supervising Criminalist and DNA Technical Manager may be 
assigned to a single person.) 
 
A. Establishes casework priorities based on negotiations and discussions with investigators and district 

attorneys. 
 
B. Assigns casework to analysts. 
 
C. Reviews reports and examines case notes. 
 
D. Reviews and evaluates the performance of subordinates. 
 
E. Works with the DNA Technical Manager to review and establish Unit specific policies and analytical 

procedures when appropriate. 
 
F. Interviews and hires new employees. 
 
G. Trains the new employees on department policies and procedures. 
 
H. Works with the DNA Technical Manager to coordinate analyst training.  
 
I. Keeps track of workload statistics. 
 
J. Prepares budget requests. 
 
K. Holds Unit meetings to disseminate department, laboratory, or unit specific information. 
 
L. Prepares reports as required by the Crime Laboratory Manager. 

 
1.3.2 DNA TECHNICAL MANAGER 

 
The DNA Technical Manager will oversee the technical operation of the DNA Laboratory as outlined by the 
SWGDAM and the Quality Assurance Standards.  The DNA Technical Manager will evaluate new 

Arch
ive

d V
ers

ion



Unit Policy Manual 
Forensic Biology 

Implemented 01/14/2019 Issuing Authority:  F. Healy, Quality Assurance Manager Page 4 of 87
 Printed documents are not controlled 

technologies, resolve technical problems, assess and design training programs, and ensure the unit adheres to 
all quality assurance guidelines.  The DNA Technical Manager is authorized to shut down the DNA laboratory 
should a serious technical problem develop. 
 
Duties and responsibilities:  
 
A. Responsible for the technical operation of the laboratory as outlined by SWGDAM. 
 
B. Reviewing, revising and approving any DNA-related technical policy or procedure prior to final 

approval by the QA Manager. 
 

C. Approving and overseeing training of new employees (when applicable) in DNA analytical procedures, 
including completion of training documentation. 

 
D. Overseeing, reviewing and approving DNA method validation, including completion of validation 

documentation, prior to final approval by QA Manager. 
 
E. Working with the QA Manager on any QA reports involving a DNA technical issue, and reviewing and 

signing off on those QA reports. 
 
F. Acting as a technical reference for the QA Manager. 
 
G. Performing some technical reviews of DNA case files. 
 
H. Acting as a mediator when necessary in the technical review of DNA casework in the Forensic Biology 

Unit. 
 
I. Providing technical consultation as needed to the members of the Forensic Biology Unit. 
 
J. Working with Supervising Criminalist and QA Manager to ensure compliance of the DNA analysts with 

QA and Unit policies and procedures. 
 
K. Reviewing the DNA proficiency tests completed by the Forensic Biology Unit. 
 
L. Conducting casework analysis. 
 
M.  Prepares reports as required by the Crime Laboratory Manager. 

 
 

1.3.3 CODIS ADMINISTRATOR 
 

The CODIS Administrator is responsible for the security and integrity of the local CODIS network, the 
CODIS software, and the data within the local database.  The CODIS Administrator ensures the data within 
the local CODIS database is in compliance with NDIS guidelines.  The CODIS administrator is authorized to 
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terminate an analyst’s or the laboratory’s participation in CODIS until the reliability and security of the 
computer data can be assured if an issue with the data is identified. If the CODIS Administrator determines at 
any point that the CODIS network, software, or entered data has been compromised, the DNA Technical 
Manager will be immediately notified.  The DNA Technical Manager and CODIS Administrator will 
determine the proper course of action to reinitiate participation in CODIS for the analyst(s) or laboratory.. 

 
Duties and responsibilities:  

 
A. Oversees the entering of DNA profiles from casework into the local database. 

 
B. Ensures that DNA profiles are searched against the local CODIS database. 

 
C. Uploads data to the California CODIS database. 

 
D. Downloads and searches DNA profiles from the CJIS WAN website.   

 
E. Performs upgrades to the CODIS software with the assistance of the CODIS Help Desk.   

 
F. Ensures that a backup is maintained for the information in the local database.   

 
G. Schedules and documents the yearly training of analysts in the operation of CODIS software. 

 
H. Disseminates CODIS information to the rest of the Forensic Biology Unit. 

 
 

1.3.4 CRIMINALIST (I AND II) 
 

The job descriptions for Criminalist I and II are similar except that Criminalist II duties may be more extensive 
and Criminalist II analysts are expected to work more independently.  In addition to the normal educational 
requirements of the Criminalist position, DNA Criminalists must complete college-level classes in 
Biochemistry, Molecular Biology, Genetics, and Statistics and/or Population Biology.  

 
Criminalist I and II’s primary duties involve locating and identifying biological material on items of physical 
evidence and performing DNA analysis.  Analysts are required to document all exams, tests, observations, 
results, summarize the findings in a written report, and if necessary, testify in courts of law. 

 
Duties and responsibilities: 
 
A. Receives, inventories, screens, and preserves items of physical evidence. 
 
B. Locates and identifies biological material.  
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C. Conducts DNA analysis to determine possible associations between the evidence and any reference 
samples provided. 

 
D. Writes reports summarizing the findings and provide expert testimony in court. 
 
E. Remains technically current and knowledgeable in appropriate analytical methods. 
 
F. Participates in the evaluation and validation of new technologies or methodologies. 
 
G. Participates in any special projects as assigned by the Supervising Criminalist or Laboratory Manager. 
 
H. Informs the Supervising Criminalist or DNA Technical Manager of problems that develop at any stage of a 

case. 
 
I. Uses the technical manual, unit policies manual and general quality assurance manual to deal with any 

procedural question or analytical method. 
 
 

1.3.5 LABORATORY TECHNICIAN 
 

The laboratory technician functions as a support position for the Forensic Biology Unit.  Duties include 
ordering supplies, calibrating instruments, monitoring operating temperature of equipment, performing 
routine maintenance of equipment, and cleaning the unit on a weekly schedule.  The laboratory technician 
maintains a database of all chemicals ordered by the Unit.  If the position of Laboratory Technician is unfilled 
the duties and responsibilities will be shared among current employees. Certain functions described above may 
be performed by volunteers or interns but only under the direct supervision of the laboratory technician or 
other qualified analyst. 

 
Duties and responsibilities: 

 
A. Checks the calibration of instruments such as pipettes, thermal cyclers, and balances. 
 
B. Orders chemicals and supplies for Forensic Biology  
 
C. Maintains an accurate inventory of all chemicals located in the Unit. 
 
D. Ensures that laboratory instruments, communal work areas, and floors are cleaned and decontaminated. 
 
E. Ensures that the operating temperatures of the Unit ovens, incubators, refrigerators, and freezers are 

monitored. 
 
F. Ensures that victim, suspect, and physiological, and reference mouth swab kits are prepared for 

departmental use or for the collection of evidence at area hospitals. 
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G. Performs other tasks as assigned by the Supervising Criminalist. 

 
 

1.3.6 INTERN/VOLUNTEERS 
 

Interns (students) and volunteers (non-students) will assist the Unit by performing certain clerical duties, 
cleaning the laboratory work areas and monitoring the operating temperature of equipment.  These activities 
will always be performed under the guidance of the Laboratory Technician or Criminalist.  The Laboratory 
Technician is ultimately responsible for making certain any duties completed by the interns and volunteers are 
performed correctly.   

 
Depending on the experience level of an intern or volunteer they may also be involved in laboratory projects 
such as the validation of new technologies. This validation work will always be performed under the 
supervision of the DNA Technical Manager. 
 
 

1.4 TECHNICAL LEAD CONTINGENCY PLAN 
 
The Forensic Biology Unit of the San Diego Police Department currently employs multiple analysts who meet 
the requirements to be DNA Technical Manager. In the event of a vacancy in the DNA Technical Manager 
position the Crime Laboratory Manager will interview the candidates and appoint a person to fill the vacancy. 
  
 
1.5  QUALITY ASSURANCE REVIEWS AND REPORTS 
 
In general, Quality Assurance Reviews will be conducted when policy or method non-compliances are identified 
in administrative practices, evidence handling, casework, or in proficiency test situations. Additionally, a Quality 
Assurance Review will be conducted on any incident of Staff DNA Contamination or in any unexpected DNA 
results in controls that compromise the interpretation or results. If a non-compliance is found to exist, then a 
Quality Incident Report will be issued. Additionally, a Quality Incident Reports will be issued on any incident of 
Staff DNA Contamination in which the likelihood ratio for the association is above the limited support category, 
or in any unexpected DNA results in controls that compromise the interpretation of the results.  Please see 
policies 2.4, 4.9.1, and 4.9.3 in the Quality Assurance Manual for further information. 
 
  
1.6 PROTOCOL FOR UNEXPECTED RESULTS 
 
Detectable DNA results from a reagent blank or amplification blank, unexplainable extraneous DNA results in a 
positive amplification control, or negative results from a positive control are considered unexpected results. 
Other types of unexpected results may exist. 
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Any unexpected results will be documented by the analyst conducting the analysis. The analyst will complete an 
"unexpected result summary" [template located on the FB network H:\Worksheets\QA worksheets] , which will be 
signed by the DNA Technical Manager and included in the "Unexpected Result Log". The log  is stored in the 
following location: H:\QA-QC files\FB QA Summaries.  
 
The summary sheet completed by the analyst will contain the following information: The case number, analyst 
name , date of summary, date of result, and the definition and evaluation of the problem. The summary will also 
detail the resolution of problem, if any, as well as the conclusion/result/interpretation. If any protocol, policy, 
or reagents will be changed as a consequence of the unexpected result then these will be documented as well. 
 
For a data set containing a control (reagent blank, positive amplification, negative amplification control, 
formamide blanks) with unexpected types to be relied upon, the unexpected results should not affect the 
interpretation (the detected types should be sample specific to the control). For any data set containing a control 
with unexpected detectable DNA types, the unexpected results normally will be disclosed in the report for the 
associated evidence samples. 

 
 

1.7 FORENSIC BIOLOGY UNIT INCIDENT LOG 
 
The purpose of the FB incident summaries are to monitor any incident that could indicate a problem with any lab 
equipment or instrument. The FB Unit Incident Log will monitor unusual events that occur during casework 
that: 

1. Are corrected prior to the issuance of any reports for the affected cases. 
2. Do not ultimately affect the reported results. 
3. Do not require formal QA documentation, unless otherwise determined by the DNA Technical 

Manager or Quality Assurance Manager. 
 
The unusual incidents will be documented by the analyst conducting the analysis. The analyst will complete an 
"Incident Summary" [template located on the FB network H:\Worksheets\QA worksheets] for inclusion in the "FB 
Incident Log". This log will be maintained electronically by the DNA Technical Manager. The DNA Technical 
Manager will be notified of any unusual incident, review, and sign off on the summary. 
 
The summary sheet completed by the analyst will contain the following information: The case number(s), analyst 
name and ID number, date of summary, date of the incident, and the definition and evaluation of the problem, as 
well as its resolution. Supporting documentation, if available, will be provided with the summary. 
 
 
1.8 PROFICIENCY TESTING 

 
Please refer to the Laboratory Quality Assurance Manual for additional information on the proficiency testing 
Program. 
 
Each DNA analyst in the Forensic Biology Unit must complete two proficiency tests in each calendar year with an 
interval between the tests of no less than four months and no more than eight months. Both of these proficiency 
tests will be external and at least one will involve DNA typing and/or body fluid identification. Analysts that 
perform Y-screen testing are considered DNA analysts for proficiency test purposes and will be tested twice a 
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year using a team approach with a fully qualified DNA analyst. Analysts conducting only traditional screening 
testing will be proficiency tested once per calendar year. For DNA proficiency tests, the due date of the 
proficiency test (as listed by the test provider) will be the date by which these tests are tracked. 
 
Proficiency tests will be worked in the same manner as casework and undergo both technical and administrative 
review. Under no circumstances should analysts compare proficiency test results prior to submitting them for 
technical review. 
 
GlobalFiler and Yfiler Plus (for those qualified) must be run on each semiannual proficiency test. Yfiler Plus 
testing must be performed on any samples with male DNA. If male DNA is detected in multiple fractions of the 
same sample (i.e., sperm and non-sperm fractions), Yfiler Plus testing is required on only one of the fractions.   
 
Results from the DNA proficiency tests will be submitted to the test provider. When the results from the test 
provider are available, the DNA Technical Manager will compare the results obtained by each analyst and inform 
them of the outcome. Analysts will initial their proficiency test packets, acknowledging the outcome, and the test 
packets will be maintained by the Quality Assurance Manager. 

 
 

1.9 FORENSIC BIOLOGY COMPUTER NETWORK SYSTEM 
 

The Forensic Biology Unit employs an independent network system comprised of several servers and client 
computers to share electronic data among criminalists, link instrumentation, maintain a centralized storage of 
data, and provide a secure connection to the Combined DNA Index System (CODIS). 

 
1.9.1 ELECTRONIC DATA STORAGE 

 
Data backup is performed automatically and is managed through the Data Systems Department of the San 
Diego Police Department.  Please contact SDPD Data Systems for additional information regarding the 
management and security of the Forensic Biology computer network. 

 

1.10 LITERATURE REVIEW 
 
Analysts within the Forensic Biology Unit will be provided copies of relevant literature (full articles, abstracts, or 
miscellaneous publications) periodically throughout the year.  Analysts will document their review of the 
circulated literature by signing off in the document management system, or on the attached routing slip.  This 
documentation will be maintained by the DNA Technical Manager. 
  
 
1.11 QUALITY CONTROL AND CRITICAL REAGENTS 

 
The following list contains the reagents deemed critical to the DNA testing process:   
 
All reagents used in the extraction of DNA (excluding dithiothreitol (DTT)) 
Qiagen DNA Investigator and QiaSymphony DNA Investigator Kits 
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All Quantifiler qPCR Kits 
All Autosomal or Y-chromosome STR Typing Kits 
 
Reagents/kits are deemed critical if the improper preparation or production of the reagent/kit could lead to an 
analyst failing to obtain a DNA type or obtaining the incorrect DNA type. 

 
1.11.1 SAMPLES AVAILABLE FOR QUALITY CONTROL TESTING 

 
Only samples with known DNA profile results will be used to assess critical reagents.  Extraction reagents will 
be quality tested using dried blood samples. DNA typing and quantification kits will be quality tested using 
previously extracted DNA samples. 
 
1.11.2 QUALITY CONTROL TESTING OF REAGENTS AND KITS 

 
Before any critical reagent or kit can be used on casework samples it must be tested in a way that would reveal 
any problems with its composition and/or function.  All quality control analysis will undergo both technical 
and administrative review.  The genotypes of the positive controls, NIST SRM, and known samples must be in 
complete agreement with their previously known STR types.  The negative control should yield no detectable 
DNA results.  If casework analysis using the new reagents or kits is required before final completion of the 
technical and administrative reviews, approval must be obtained from the DNA Technical Manager prior to 
using the kits. 
 
In the event that the QC data is unacceptable, a second run of the QC samples can be used to demonstrate the 
reliability of the reagent or kit.  If the cause of any failure is deemed to be reagent or kit related, then the 
critical reagents tested will not be approved for casework and, if applicable, the vendor of the reagent will be 
contacted.   
 
The critical reagents/kits will be tested as follows: 
 
Extraction Reagents:  Two different known samples and a reagent blank will be carried through DNA extraction 
and typing.  The preparation dates of the reagents and the results of the DNA testing will be documented on 
the Quality Control Worksheet for Critical Extraction Reagents.   
 
Qiagen (EZ1 or QiaSymphony) DNA Investigator kits:  Two different known samples and a several concentrated 
(note: concentration factor not to exceed 8x) reagent blanks (some eluted in TE and some eluted in water) 
will be carried through DNA extraction and typing.  The kit, reagent strip lot numbers, and the results of the 
DNA testing will be documented on the Quality Control Worksheet for DNA Investigator kits. 
  
Quantifiler kits:  The DNA standard tubes from the new lot of Quantifiler Duo kits should be defrosted, pooled, 
and re-distributed into the DNA standard tubes.  The new lot of kits should be used to quantify calibrators 1 
and 2 from the old lot of kits as well as three replicates of calibrators made with the current lot of kits.  Two 
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samples with known genotypes should also be quantified using the new Quantifiler Duo kit(s), the obtained 
quant values should be used to amplify those samples (and appropriate controls) using one of the validated 
typing kits.  All samples should produce the known genotypes and the peak heights should generally be 
consistent with expectations based on the input amount of DNA.  The target volume of the QC samples will 
be determined based on the quantification value obtained from the new Quantifiler Duo Kit.  Successful typing 
of the known samples will serve to demonstrate the reliability of the new kit lot(s).  
 
GlobalFiler DNA typing kits:  007 Control DNA should be defrosted, pooled, and re-distributed into the DNA 
standard tubes prior to performing the QC testing. Two known samples will be typed along with the 007 
Control DNA positive control and an amplification blank.  The lot numbers of all kit components and the 
results of the DNA testing will be documented on the Quality Control Worksheet for GlobalFiler.    (See also 
the NIST Testing policy below) 
 
Yfiler Plus DNA typing kits:  New kit lots will be tested with two known male samples, the 007 DNA positive 
amplification control, and an amplification blank.  The lot numbers of all kit components and the results of the 
DNA testing will be documented on the Quality Control Worksheet for Yfiler.   
 
All QC data will be stored electronically on the FB network.  
 
 

1.12 NIST TESTING OF DNA PROCEDURES 
 

Once a year, the DNA typing process will be checked against NIST or NIST-traceable standards.  Previously 
extracted known DNA samples can be tested alongside NIST SRM samples, thus making them NIST traceable.  If 
kits are quality controlled using these NIST-traceable samples, this check will serve as the yearly check against 
NIST standards. 

 
1.13 EQUIPMENT VERIFICATIONS 

 
Performance verifications will be performed on the following equipment that has been identified as being critical 
to the analysis of samples in the Forensic Biology Unit.  The performance of this equipment will be assessed at 
approximately the intervals indicated. If any of the instruments in the list is taken out of service, prior to re-
initiating casework on the instrument, a performance verification will be performed. 
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Equipment Item Location Schedule (approximate) 

Pipettes Forensic Biology Main Lab and 
Amplification Room 

Every six months 

Balances Forensic Biology Main Lab 
and Amplification Room 

Every three months 

BioRobot EZ1s Volume Test Forensic Biology Main Lab Every six months 

QIASymphony Forensic Biology Main Lab Annually 
 

QiaCubes Forensic Biology Main Lab Annually 

Hamilton Nimbus Forensic Biology Main Lab Every six months 

Thermal cyclers Amplification Room Every six months 

SDS 7500 
Block Contamination Check 
All other calibrations 

Amplification Room  
Every six months 
Annually 

Genetic Analyzers Amplification Room Annually 

Corbett CAS-1200 Amplification Room Annually 

 
Pipettes – a performance check of a pipette consists of an evaluation as to the accuracy of the volume delivered 
against the selected volume.  A passing result must be within 5% of the selected volume. 
 
See the equipment maintenance protocols section (section 6) for additional information. 
 

1.13.1 INSTRUMENT VERIFICATIONS 
 

If any maintenance, repair, or service is conducted on a piece of equipment, a performance verification will 
be performed. 

  
1.13.1.1 QiaCubes - preventive maintenance will be performed on the instrument on a yearly basis. 

After any service visit, including the yearly preventive maintenance, the QiaCube(s) will be 
evaluated with a performance verification. This verification will aim to establish if the 
instrument performance is acceptable for casework applications. This is accomplished by 
determining if the service issues were corrected and that the instrument(s) can still perform 
the methods as expected. One way of determining this is to run a set of mixed sperm/non-
sperm cell samples through the QiaCube and continue the analysis through both quantification, 

Arch
ive

d V
ers

ion



Unit Policy Manual 
Forensic Biology 

Implemented 01/14/2019 Issuing Authority:  F. Healy, Quality Assurance Manager Page 13 of 87
 Printed documents are not controlled 

amplification, and CE analysis. Satisfactory performance will be determined by the ability to 
separate the sperm and non-sperm fractions of the verification samples. 
  

1.13.1.2 BioRobot EZ1s – every six months a volume test will be conducted on all BioRobot EZ1s to 
determine whether pipetting performance is still optimal. See the equipment maintenance 
protocols section (section 6) for additional information. A passing result must be within 5% of 
the pipetted volume for all channels within the instrument. 

 
1.13.1.3 QiaSymphony - preventive maintenance will be performed on the instrument on a yearly 

basis. As part of the preventive maintenance visit, the pipetting accuracy and precision are 
checked for all 4 channels. This is documented in the volume verification report. After any 
service visit, including the yearly preventive maintenance, the QiaSymphony will be evaluated 
with a performance verification. This verification will aim to establish if the instrument 
performance is acceptable for casework applications. This is accomplished by determining if 
the service issues were corrected and that the instrument(s) can still perform the methods as 
expected. One way of determining this is to run a set of samples through both quantification 
set-up and amplification setup protocols. Replicate samples could also be run on the BioRobot 
EZ1(s) to demonstrate satisfactory performance. 

 
1.13.1.4 Hamilton Nimbus – preventive maintenance will be performed on the Nimbus instruments 

approximately every 6 months. As part of the preventive maintenance visit, the pipetting 
accuracy and precision are checked for all 4 channels. This is documented in the volume 
verification report.  

 
After any service visit, including the yearly preventive maintenance, the Nimbus instruments 
will be evaluated with a performance verification. This verification will aim to establish if the 
instrument performance is acceptable for casework applications. This is accomplished by 
determining if the service issues were corrected and that the instrument(s) can still perform 
the methods as expected. One way of determining this is to run a set of samples through both 
quantification set-up and amplification setup protocols. Replicate samples may be used to 
assess pipetting volume accuracy and precision during the quantification setup.  
 
Any changes to the methods (i.e., robotic instructions underlying the procedure) will require a 
modification study to determine whether the changes have adversely affected performance. 

 
1.13.1.5 Genetic Analyzers - the QC analysis of critical reagents will serve as the annual performance 

verification of the Genetic Analyzers.  The QC runs performed for the various testing kits 
employed by the lab will be rotated through the various Genetic Analyzers throughout the 
course of the year. Performance checks separate from QC runs may also be done using a 
minimum of the amplification positive, amplification negative and allelic ladder.  
 
After any service visit, including the yearly preventive maintenance, genetic analyzers will be 
evaluated with a performance verification. This verification will aim to establish if the 
instrument performance is acceptable for casework applications. This is accomplished by 
determining if the service issues were corrected (if applicable), electrophoresis capabilities 
(i.e., resolution) are acceptable, and that the sensitivity of the instrument has not been altered 
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substantially. One way of determining this would be to evaluate data from a set of samples run 
pre-service and comparing it to data from the same samples run post-service. 
  

1.13.1.6 Corbett CAS-1200 – the performance check of the CAS-1200 will consist of an evaluation of 
the instruments pipetting against manual pipetting of the same samples.  This will be 
accomplished based on the CAS-1200 pipetting of a known set of replicate samples for analysis 
on the genetic analyzer.  The results of the replicate CAS-1200 pipetted samples will be 
compared against the same replicate samples prepared manually.  Total detected peak heights 
of both sets of samples will be used to measure the performance of the CAS-1200.  Although 
several variables will affect the ultimate peak heights on the 3500, ideally the difference 
between the total peak heights both sets of samples should be less than 10%. 

 
1.14 POLICY FOR MONITORING INCUBATORS, REFRIGERATORS, AND FREEZERS 

 
The incubators, refrigerators, and freezers in the Forensic Biology Unit will be monitored approximately every 
week.  The operating temperatures should be recorded on a worksheet attached to the equipment.  Refrigerators 
will be expected to operate at a temperature between 1 to 13oC and freezers at a temperature colder than -10oC.  
Consistent deviations from the expected temperature indicate that maintenance or repair is likely required and 
the Supervising Criminalist of the unit will be notified. 

 
1.14.1 MICROSCOPES 

 
The microscopes in the Forensic Biology Unit will be maintained according to policies outlined in the 
laboratory Quality Systems Manual. 
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1.15 QUALITY ASSURANCE LOGS FOR THE FORENSIC BIOLOGY UNIT 

 
This list below indicates all the logs maintained by the Forensic Biology Unit: 

 

Log Name Location 

Kit Receipt Log Electronic 

Reagent Preparation Logs Electronic 

Supply Order Log Electronic 

DNA Extraction  Electronic 

Qiagen Robot Reagent QC Electronic 

GlobalFiler QC Electronic 

Y-STR QC Electronic 

Quantifiler Duo QC Electronic 

Unexpected Results Electronic 

FB Incident Log Electronic 

Staff Associations Electronic 

Balance Calibration Tests Electronic 

Pipette Calibration Electronic 

Nimbus Maintenance Electronic 
Thermal Cycler Calibration & Uniformity Electronic 

3500 Maintenance Electronic 
Ovens & Fridges Temperature Log Electronic 

Qiagen EZ1 Volume Test Electronic 
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2.0  CASE PACKETS AND REPORTS  
  

2.1 REPORT FORMAT 
 

The Biology Unit will use the standardized report format located in the Quality Systems Manual.  Case number, 
incident number, and date of occurrence will appear in the report header whenever possible.  In addition to the 
items listed in the Report Standard Format section of the Quality Assurance Manual, the date of the report will 
be included in the initial header and on each subsequent page for multi-page reports.  In general, items described 
in the report will be limited to those examined or tested.  Where available, CII numbers will be included in the 
report. 

 
2.1.1 BACKGROUND SECTION 

Any references to external data used to render conclusions in the current report must be 
referenced in the background section, or in the conclusion section if citing information relating to a 
database hit. The use of the background section to provide additional details that may be relevant to 
the reader(s) of the report is optional.   
  

2.1.2 CASE-TO-CASE NOTIFICATIONS 
When providing information to investigators regarding links between evidence in different cases, 
tabular case-to-case hit notifications will be issued detailing the various cases linked through DNA 
evidence.  These notifications must be technically and administratively reviewed prior to issuance. 
 
Case-to-case notifications will be required when an unsolved SDPD case has been linked through 
the database to any unsolved SDPD case or any case from an outside agency.  In general,  case-to-
case notifications will be issued for any newly solved cases linked to previously solved cases with 
the same suspect (no notifications are necessary for the previous case(s)). 
 
If a newly analyzed unsolved case is linked to a previously solved case or cases, a case-to-case 
notification will be issued for the new case.  The determination of whether additional notifications 
will be issued for the older cases will depend on case type, the statute of limitations on the old 
cases, and/or the time interval between cases.  
   

2.1.3 SCREENING REPORTS 
Screening results can be summarized either through the inclusion of a table or through written 
explanations of the results. 
 

 
2.2 CASE PACKETS 

 
The final packet assembled by the analyst will contain the original of the final signed report, complete 
analytical record (or a reference as to where the data is located), and other important administrative 
documents (e.g., work requests) for scanning and storage by the Clerical Unit.  The final packet is subject to 
technical and administrative reviews before the packet is filed. 
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Numbering of administrative documents as part of the analytical record will be at the analyst’s discretion.  
All additional documents in the case packet (e.g., administrative documents) will be denoted as 
administrative document (or Admin. Docs.) and include the case number on the first bound page or on all 
unbound pages.  Administrative documents should be binder clipped or paper clipped together. 
 
No loose items such as sticky notes (i.e., post-it notes) or photos will be included in the packet.  Small items 
must be mounted on 8 1/2" x 11" sheet paper. Stickers placed on 8½ x 11” sheets of paper do not need to 
be initialed and dated if they are added on the same day the note page is dated. 
 
If any information is referenced within the analytical record (e.g., a reference sample worked as part of a 
different case), a pink sheet indicating that the report relies on information contained within a case packet 
from a different case.  This sheet will serve to notify clerical that additional material is required in the event 
of a discovery request. 
 
2.2.1 ANALYTICAL RECORD 

In general, the analytical record will contain the following: 
 

Chain of custody information 
Documentation of relevant communications 
Evidence inventory and analysis notes, including any serology tests results 
DNA extraction, quantification, amplification, and capillary electrophoresis notes 
DNA results (elctropherograms) 
Interpretation information/worksheets 
STRmix results page with diagnostic information of the MCMC 
Statistical evaluations 
CODIS worksheets printouts for any samples to be uploaded to CODIS 
Disposition information for work product 

 
2.2.2 CASEWORK BATCHING 

To streamline the administrative burden (case, packet assembly, technical review, and 
administrative review) of processing large numbers of cases together, analysts may group the 
analytical records for multiple cases together into a single analytical record. Each case in the 
casework batch should receive its own individual report.   
 
Alternatively, the analytical worksheets common to multiple cases (i.e., extraction through GMID-
X) can be technically and administratively reviewed separate from the complete analytical record.  
The technical and administrative reviews shall be documented in the complete case packet, and the 
analytical batch only referenced. These analytical batches must be stored on the FB network such 
that they are available for review when the complete case packets are reviewed.  Please see section 
2.6.1 for additional information on technical review. 
  

2.2.3 NOTETAKING 
The chain of custody worksheet requires, at minimum, the case identifier, a unique identifier of the 
item(s) received, and the date and locations obtained/returned.  The Chain of Custody Worksheet 
together with the body of the notes must uniquely describe the packaging, condition of the item, 
and complete contents of the item received.   
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Analysts should avoid using the names of victims of sexual assault or child abuse cases on 
worksheets containing information from multiple cases to reduce the risk of the information being 
revealed through unrelated cases. 
  
The analyst will take notes with the expectation that they, a technical reviewer, or perhaps an 
outside expert, upon review (even years later) will be able to reconstruct what was done in terms 
of examinations conducted, testing completed, and any sampling. 
  
Photographs will be labeled with a descriptor unless it is completely evident what the photograph 
represents.  Photographs should ideally include scale. 

  
Digital photographs taken in the Forensic Biology Unit will be archived so that they can be easily 
retrieved, if needed, for discovery.  At a minimum, the electronic files of the photographs should 
be saved with the barcode of the item in the file name in a folder labeled with the case number.  
  

 
2.3 INTERPRETATION OF CONTROLS 

 
2.3.1 SUBSTRATE CONTROLS 

 
For any analysis, a result obtained from a questioned stain is interpreted as being representative of the stain 
when the result from the substrate control is negative. 
 
Results from questioned stains for which the substrate control yields a positive result need to be interpreted 
with caution.  A result from a questioned stain may not be representative of the stain when the substrate 
control also yields a positive result.  In this circumstance, the results obtained from the questioned stain 
need to be considered along with the results obtained from the substrate control. 
  
Some considerations for evaluating the substrate control include: 
 
A. The collection of the substrate control.  (e.g. Was the control collected from a proven negative area?) 
 
B. Results from presumptive test versus a quantitative test.  Was the substrate control originally evaluated 

as being negative by a presumptive test, which is less specific than the confirmatory test? 
 
C. Did the substrate control give a low level DNA result versus a considerably higher level DNA result 

from the questioned stain? 
 
D. The source of the substrate.  Is there a stain on the substrate control, which was not identified 

presumptively, which could be giving the result?  It may be necessary to examine the substrate for other 
body fluids. 
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2.3.2 DNA CONTROLS: 
 

Please refer to the Autosomal STR Interpretation Guidelines (or Y-STR Interpretation Guidelines section) 
section of the Forensic Biology Technical Manual for the policies regarding the interpretation of the 
Reagent Blanks, Positive Amplification Controls, and Negative Amplification Controls. 
 
 
 

2.4 CASEWORK REVIEW 
 

All casework performed by the Forensic Biology Unit is subject to both technical and administrative reviews.  
Refer to the casework review policy in the Quality Assurance Manual. 

 
2.4.1 TECHNICAL REVIEW 

 
Each case packet prepared by an analyst in the Forensic Biology Unit is subject to technical review by a 
second qualified analyst.  Technical review will rotate between all qualified analysts in the Forensic Biology 
Unit to ensure that the process remains objective. 
 
The purpose of the technical review is to check the accuracy of the final report and ensure that established 
Forensic Biology protocols are being applied to case analysis.  The final report should adhere to the 
established laboratory format (see the Quality Assurance Manual for more information) and the conclusions 
in the report must be supported by the data in the analytical record (case notes, sketches, photos, etc.). 
 
The analytical record serves as the basis for all conclusions set forth in the final report and will be evaluated 
in the technical review process.  The analytical record will be examined by the technical reviewer to ensure 
that it is complete and current Forensic Biology Unit procedures (including interpretation guidelines) and 
policies for the examination and testing of biological evidence were followed.  Any material changes to the 
analytical record that affect the interpretation of any result, or the statistics applied to a DNA association, 
made as a result of the technical review, will be kept as part of the analytical record.  Analysts must note that 
the changes were as a result of the technical review process. 
 
The goal is to have the initial round of technical review completed with a two calendar week period.  Any 
final review after a file is re-submitted to the technical reviewer should be completed within a few days of 
the re-submission.  The date of the completion of the technical review will be documented in the report and 
in the analytical record.  The completion dates of the report and analytical record can be different.  It is the 
responsibility of the analyst to let the technical reviewer know of any rush status on a case given for review.  
It is the responsibility of the technical reviewer to communicate with the analyst if anything (vacation, 
training, etc) will delay the completion of the review. 
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Unresolved differences between the case analyst and the reviewing analyst can be addressed with the DNA 
Technical Manager. 
 
The following list is meant to guide analysts in providing a complete technical review of case packets.  The 
list is not meant to be all inclusive and a case needs to be evaluated in its entirety to make certain that a 
reasonable, competent, and complete analysis was performed. 
 

Analytical Record 
     All additional materials in case file labeled with “Admin Document” 

DNA request has supervisor and/or analyst initials 
Notation from supervisor or communication with detective documented for requested samples    
that were not tested 
All other requested evidence and reference samples tested 
Case file has pink case reference sheet and/or green stat sheet, if applicable 

     Date, initials, page numbers, and case # / incident # on each page 
Corrections are lined out, initialed, and dated (if applicable) 

     Chain of custody exists for all evidence during analysis in Forensic Biology 
If applicable, permission to consume evidence obtained and/or communicated 
All important communications concerning the case appear recorded 

Evidence Sampling 
There is an adequate description of the evidence packaging 
There is an adequate written or pictorial representation for evidence examined 
There is an adequate written or pictorial representation for samples collected 

     If applicable, photographs (if affixed to page) have proper identifying information 
     Proper methods were used to locate biological material  

Proper methods were used to identify biological fluids 
Appropriate controls were used for alternate light source and presumptive tests 

     Substrate controls collected and analyzed where appropriate 
     Documentation present that evidence was repackaged and sealed 
     Sub-item designations added to packaging and comments section in FileOnQ 
     If applicable, "SART Kit Tested" field is updated in FileOnQ 
Analytical Notes 
     Reviewed (TR/AR) Analytical Batch review page present, if applicable 

Analytical notes not part of analytical batch contain necessary documentation 
If applicable, QA  Incident Summary documentation present in notes or in Analytical Batch 
Suitable amounts of DNA amplified for evidence and controls for the STR system 

     Positive Control results acceptable 
     Amplification Blank (TE) results acceptable 

All associated Reagent Blanks have acceptable results 
Electropherograms 

Appropriate analysis method, panel, and size standard used for all samples 
Electropherograms present for all relevant samples 
If altered injection times used, controls were injected appropriately 
Multiple injections performed where necessary 
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If multiple injections performed, results generally consistent/expected 
Artifact and allele changes labels appropriately and sufficiently 
Loci with common microvariant alleles (X.1 or X.3), have no stutter peaks or alleles above detection 
threshold that did not fully resolve from neighboring peaks 
Heterozygous peaks in apparent single source samples appear to be balanced 

Interpretation 
Assumptions regarding number of contributors are documented 
Conclusions based on visual comparison are documented 
STRmix run for all appropriate samples 
STRmix input files imported correctly for evidence samples 
If applicable, MCMC conditioned on appropriate references and the text file was imported appropriately 
MCMC results appear to have appropriate genotypes, weights, and mixture proportions 
If applicable, MCMC run with appropriate informed priors 
STRmix database search results evaluated for possible staff matches 
Comparisons were made to all relevant reference samples and the input files were correct 
LRs do not have large disparities in results at any loci (i.e., LR = 0 at only a single locus) 
STRmix diagnostics within reasonable range of values 
For Y-STRs, designation of major and minor contributors is appropriate 
For Y-STRs, appropriate comparisons were performed and conclusions drawn 
For Y-STRs, appropriate statistical assessment of evidence performed 

CODIS 
CODIS sheets present for applicable evidence 
If applicable, MME is calculated appropriately for eligibility for SDIS/NDIS 
CODIS sheets present for applicable suspects 
All CODIS sheets have appropriate case #, item #, contributor %, specimen category, and offense 
information 
All CODIS profiles have correct specimen category and DNA types 

Report 
Header is correct on first page And correct on additional pages 
If applicable, Supplemental Report info and Background are appropriate 
Evidence examined contains correct barcode and appropriate description of items 
Evidence examined contains results of presumptive/confirmatory testing 
DNA typing kit(s) listed in Evidence Examined or in Conclusions 
Conclusions have appropriate barcode and description (and fraction for diffs) 
Conclusion lists number of contributors and mixture proportions, if appropriate 
Conclusions include appropriate verbal wording for LR for each contributor 
Reported LR for inclusions use lowest HPD for all four populations 
 
Point LR reported for inclusions with no effective sample size, and inclusions with greater than 106 
difference between LR and HPD 
Disposition of evidence contains appropriate information 
Signature block is correct 
Analytical batch(s) listed in report 
If applicable, Quality Assurance Incident documented appropriately in report 
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ANALYTICAL BATCH REVIEW 

 
The review of an analytical batch (see section 2.2.2) is designed to streamline the reviewed process by not 
requiring duplication of data review. The following list is meant to guide analysts in providing a complete 
technical review of the analytical material in a batch. 
 

Packet 

□ Date on each page 

□ Initials on each page 

□ Page Numbers on each page 

□ Analytical batch name on each page 

□ Corrections are lined out, initialed, and dated (if applicable) 

Extraction Worksheets 

□ Appropriate volume of Digest Buffer/ Prot. K (and DTT) 

□ Correct Preparation date for Digest Buffer/ Prot. K (and DTT) 

□ Incubation time ≥ required minimum 

□ Appropriate elution volume 

□ TE or dH2O Elution box checked 

□ EZ1 instrument indicated for each sample 

□ Correct Reagent Strip Lot # 

□ Reagent blanks included 

Quantitation Worksheets 

□ Correct Quantifiler (Human or Duo) lot # 

□ 7500 Instrument listed 

□ Setup listed 

□ Master Mix Preparation was accurately calculated 

□ Calibrators are within appropriate range 

□ TE Amp Blank is undet and IPC is green 

□ All reagent blanks are undet and IPC is green 

Amplification Worksheets 

□ Correct Amplification Kit (GlobalFileror Yfiler Plus) lot # 

□ Correct TE Prep Date 

□ Thermal Cycler Instrument listed 

□ Setup listed 

□ Master Mix Preparation was accurately calculated 

□ Correct volume for Positive Control added 

□ Correct volume for TE Amp Blank added 

□ If samples combined, corresponding RBs are combined 

□ Correct volume for Reagent Blanks added 
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□ Dilutions (and/or) concentration procedures listed below table 

3500 Sample Setup Worksheets 

□ Formamide Blank and Formamide ISS included 

□ Ladders included 

□ Positive and negative control included 

□ Reagent blanks included 

□ 3500 Instrument listed 

□ Sample setup listed 

□ Correct Reagent Lot #s (Formamide, ISS, Ladder) 

GeneMapper Analysis (electronically viewed) 

□ Sample page included in packet 

□ At least 1 evidence and 1 reference ladder passed 

□ All GS600 – Appropriate peak heights and resolution 

□ Positive Control passed 

□ TE Amp Blank (No detected DNA types) 

□ All Reagent Blanks (No detected DNA types) 

 
TECHNICAL REVIEW EXPECTATIONS 
 
The following serves as a further clarification of the expectations with regards to the technical review 
process should differences of opinion arise: 
 
1. The Analyst and Technical Reviewer will meet in person and have a verbal conversation in an effort to 

sort out any differences of opinion.  Each should have the opportunity to professionally explain their 
point of view.   

2. Assuming the analyst and technical reviewer cannot come to an agreement; the input of a DNA 
Technical Manager will be sought.   

3. Should the issue raised in technical review have policy implications, the Technical Manager may need to 
consider a policy change.  In this case, the Technical Manager will work with the Supervising 
Criminalist(s) and/or the Quality Assurance Manager to determine the best course of action. 

4. Assuming an agreement between the Analyst, the Technical Reviewer, and Technical Manager cannot 
be achieved, the Quality Assurance Manager will be asked to assist the three parties in coming to a 
resolution for the technical issue. 

5. Should the technical review issue still remain unresolved the Supervising Criminalist for Forensic 
Biology will be informed of the impasse. 

6. Analysts involved in the discussion may elect to have further discussions with the Laboratory Director 
concerning the technical issue. 

 
2.4.2 ADMINISTRATIVE REVIEW 
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Each case packet prepared by an analyst is subject to administrative review.  This review is normally 
conducted by the Supervising Criminalist; however, in the event a Supervising Criminalist is unavailable the 
administrative review may be performed by another analyst within the section. 
 
The Quality Assurance Manual details the basic elements of the administrative review process. In addition to 
those criteria enumerated in the Quality Assurance Manual, the following list is meant as a guide to 
providing a complete administrative review of case packets.  The list is not meant to be all inclusive and a 
case needs to be evaluated in its entirety to make certain that the report and analytical record are complete. 

 
Notes 

The chain of custody during testing in the laboratory is documented? 

Worksheets are complete? 
Report 

Conclusions in the report are supported by the data? 

Statistical frequencies provided for DNA profiles when appropriate? 

Evidence disposition is summarized? 
General 

Report and case notes have had a technical review by a qualified analyst? 
Analyst has corrected or otherwise resolved all concerns raised by the analyst performing the 
technical review? 
CODIS worksheets for appropriate samples? 
If SART kit is tested, has File-on-Q has been updated? 

 
2.5 INTERNALLY PRODUCED DNA REQUESTS 

 
Introduction: 
If an analyst performs initial analysis on casework in the Forensic Biology Unit, where there are positive findings 
for which they will not be performing the subsequent DNA analysis, they will submit a DNA request to the 
Supervising Criminalist.  
 
If subsequent DNA testing is being requested by an analyst, the screening report will indicate the submission of a 
DNA request, and the Supervising Criminalist should be contacted concerning the status of the request. 
 
Guidelines for Request Submission: 
If no history is given or multiple suspects may be involved, all potentially probative samples should be forwarded 
for DNA testing in order to maximize the potential of obtaining DNA profiles from all offending parties. 
 
A DNA analyst may request further work on unanalyzed items of evidence after obtaining the initial round of 
DNA testing results.  Any additional work should be coordinated through the Supervising Criminalist. 
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DNA analysis of a case is often assisted by the inclusion of the original screening request, microscopy worksheet 
page(s), or Y-screen quantification results.   
 
DNA analysts require additional information such as case scenario, consumption issues, reference sample 
availability, presence of consensual partners/multiple assailants, and the existence of other evidence that should, 
when available, be included on internally produced DNA requests.  If only clothing samples are listed in a DNA 
request a summary of the screening results from the previously examined SART kit should be included in the 
request (if available).  The DNA request will document what additional evidence is available in the case. 
 
If a large cutting is necessary to obtain DNA results, multiple cuttings can be placed in separate tubes or the 
entire stain can be removed and impounded within a freezer packet.  This will be documented on the DNA 
request.  
 
When liquid blood is being used as a reference sample, between 10-15uL of liquid blood should be submitted for 
DNA testing.  A reference bloodstain card must be prepared in this circumstance (suggested sample size = 1mL).  
This newly created item must be given a barcode through the File-on-Q system and its disposition documented in 
the report. 
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3.0  EVIDENCE POLICIES 
 

3.1 CASE SUBMISSIONS 
 

The Forensic Biology Unit accepts case submissions from all investigative units with the Department.  Case 
submissions are handled as described in the Quality Assurance Manual. 
 
Department Order 13-30 requires a consent form when collecting DNA from a subject who is not being arrested 
for a felony, is not a 4th waiver subject, is not subject to a court order mandating collection of a DNA sample, or 
who is not a victim of a sexual assault. The consent form is used to inform the subject of his or her right to refuse 
to have a sample collected, and will inform the subject that the sample, if collected, may be entered into a 
database for comparison with other profiles.  Any reference DNA sample requested must have a form submitted 
in order to have the sample analyzed, unless it has been collected from a felony arrestee, court order, 4th waiver 
subject, or sexual assault victim. If no form was collected, permission from the Assistant Chief in the requestor’s 
chain of command will be required to proceed with analysis. The consent form or documented Assistant Chief 
approval will be maintained as an administrative document. 
 

3.1.1 CASEWORK STATISTICS 
 

Casework statistics are recorded for each case that is analyzed and are tallied in monthly statistics for the 
Unit.  Supervisors report case statistics for the unit to the Laboratory Manager. 

 
 

3.2 CONSUMPTION OF EVIDENCE 
 

General QA Policy: 
When possible, sample(s) will not be consumed in testing so that a sufficient quantity is retained for reanalysis.  If 
the entire sample(s) must be consumed during analysis, the assigned DDA will be consulted whenever possible.  
If there is an objection to the SDPD lab consuming the evidence, alternative arrangements will be made for the 
analysis of the sample(s) in question.   
 
In all cases, with or without a suspect and/or no DDA assigned to the case, a notification will be sent to the 
detective informing him or her of the decision to consume the sample(s). Three business days will be given to the 
detective to provide an opportunity to respond. The analyst will proceed with evidence consumption in the 
absence of a response. 
 
Discussion: 
If the decision of an analyst is that consuming an item of evidence provides the best chance of obtaining a DNA 
result and there is an issue with the laboratory consuming the evidence, an analyst may agree to initially consume 
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half of the sample (predicated on the subsequent analysis of the remaining portion of the evidence if needed) or 
may suggest that an independent laboratory be selected to perform the analysis. 
 
For cases where there is no DDA assigned, the investigators will be informed of the intent to consume the 
evidence through an email.  For cases without suspects a form email has been created for the purposes of 
informing investigators about the consumption of any evidence.  The requirement of the email allows for 
documented communication. 
 

 
3.3 UNIT POLICIES FOR EVIDENCE HANDLING 

   
In an attempt to maintain a high level of quality in all aspects of the analyses performed by the Forensic Biology 
Unit, the following policies and practices will be adhered to wherever possible: 
 

3.3.1 GENERAL: 
 

See the laboratory’s Quality Assurance Manual for general evidence handling requirements.   
 

 Separate areas are designated within the Unit for DNA extraction, PCR setup, and for the analysis of 
amplified DNA.  Procedures will be performed in the appropriate area for that analysis.  

 

 Prior to analysis, the work area must be cleaned with a 10-20% bleach solution. The work area will be 
covered with clean paper or bench mats.  The contents of items must be inventoried and examined on a 
fresh piece of paper.  This paper can be used to wrap the item after examination. 

 

 All items examined must be marked with a minimum of the barcode and analyst initials.  If 
circumstances prevent or preclude marking the item directly only their proximal containers will be 
marked.  Any analysts performing verifications need only mark their initials on an item. 

 

 When evidence to be analyzed is retrieved from the Property Room or Laboratory Vault the condition 
of packaging will be noted (i.e., damaged, unsealed, etc).  When opening an item, care must be taken 
to avoid compromising any information written on the packaging.  If possible the original seal will not 
be broken.  If the contents of the packaging cannot be accessed without breaking the seal, then a 
notation will be made in the case notes. 

 

 An analyst will wear appropriate safety gear and disposable gloves when handling evidence within the 
unit.   

 

 Slides or other derivative evidence generated as a result of analysis are generally given a new barcode in 
File-on-Q system, a notation as to final disposition will be made in the notes.  
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 Digital images will be taken of most evidence and color laser prints of these images will appear in the 
case notes.  An archive of all digital images taken by Forensic Biology analysts is maintained on the FB 
network. 

 

 After analysis, items will be returned to the original packaging if possible. The package must be sealed 
with evidence tape and the analyst must initial and date the seal.  The barcode number must be on the 
outer packaging. 

  

 For any procedure performed in the Forensic Biology Unit only one tube or evidence item should be 
open at a time during any sampling and reagent/DNA addition.  Use of any robotics system for sample 
setup is an exception to this policy. 

 

 Within the Forensic Biology Unit there are separate refrigerators and freezers dedicated to the storage 
of either reagents or evidence.  Evidence and reagents should be stored separately in their designated 
locations while in the Forensic Biology Unit. 

 
 If an evidence item is swabbed for DNA analysis, a notation will be made within the File-on-Q evidence 

tracking database regarding any sub-designations assigned, or additional associated barcodes created. 
 

3.3.2 CASE APPROACH 
 

 Communication between units is important in determining the sequence of examination.  A unit able to 
individualize evidence has priority over a unit, which can only determine class characteristics.  
Destructive examinations will be carried out as a last resort. 
 

 The danger of cross-contamination must be recognized and steps taken to prevent it.  Evidence 
collected from the suspect(s) must not be sampled or extracted at the same time as evidence collected 
from the victim.  In addition, case scenario information relating to the locations evidence items were 
collected should be considered so that evidence collected from locations associated with the victim are 
not extracted with evidence from locations associated with the suspect. The DNA extraction of 
evidence and reference samples must be separated by time and/or place.   
  

 Cigarette butts will go straight to DNA analysis prior to any attempt at latent print development.   
 

 It must not be assumed that swabs from the same area packaged separately are equivalent.  If body cavity 
swabs from a sexual assault kit are submitted in multiple tubes, analysts are obligated to test swabs from 
both tubes. 

 
 In general, if a single swab is collected in a Child Abuse case, the swab will be directly analyzed for 

DNA in an attempt to preserve as much DNA on the sample as possible.  Any decision to initially 
consume less than a full swab for non-DNA testing should be discussed with a Supervising Criminalist.  
That communication must be documented in the case notes. 
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3.3.3 DNA EXTRACTION: 
 

 When sampling for DNA analysis a clean cutting surface should be used for each piece of evidence.  
Clean scissors or scalpel blades thoroughly with bleach, soap and water, alcohol, or by flaming after 
cutting each evidence sample.  Alternatively, use a fresh scalpel blade with each evidence sample. 

 

 All reagents and solutions will be sterilized where possible.  Sterile water and sterile plastics or 
glassware will be used for solutions that cannot be autoclaved. 

 

 Reagents will be stored as small aliquots to minimize the effects of any contamination events.  The lot(s) 
of reagents used for each set of analyses will be recorded so that if contamination occurs, it can be 
traced more readily.  

 

 Sterile disposable aerosol resistant pipette tips and sterile tubes will be used for any processes involved 
in DNA analysis.  Pipette tips will be changed between adding and/or removing liquid from evidence 
samples. 

 

 It is advisable to briefly centrifuge all tubes before opening to remove liquid from the caps. 
 

 The number of samples processed at one time should be limited to a manageable number.  This 
precaution will reduce the risk of a sample mix-up and the potential for sample to sample 
contamination.  The manageable number of samples will vary depending on the experience and comfort 
level of an analyst. 

 

 The DNA extraction/purification of questioned samples will be performed separately from the DNA 
extraction/purification of reference samples from the same case.  This precaution will help to prevent 
potential cross-contamination between reference and evidence samples.  In addition, it is advisable that 
DNA extraction/purification of samples, where high amounts of DNA are expected, (references or 
large bloodstains) be performed separately from samples where low amounts of DNA are expected 
(single hairs or very small stains) to minimize the potential for sample to sample contamination. 

 

 Only unamplified DNA samples will be stored in the refrigerators and freezers in the extraction area.  
No reagents used in the post amplification processes will be stored in any refrigerator or freezer in the 
DNA Extraction Area. 

 

 At least one reagent blank will be employed for each set of DNA extractions/purifications to check for 
possible contamination of the DNA extraction reagents or DNA Extraction Area.  A reagent blank is 
subjected to all of the reagents and manipulations of the DNA analysis process, but contains no sample.  
The reagent blank(s) should be treated in the same manner as the most manipulated evidence sample 
associated with it.  The reagent blank will be carried through amplification and analysis with its 
associated samples.  It is advisable to employ multiple reagent blanks in a batch extraction to 
accommodate the combining of samples, or the use of multiple DNA testing kits if any samples are 
consumed during a first analysis. 
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 Performing the initial water wash and microscopic examination will be optional for samples that have 

previous serological, or Y-screen examinations performed.  For reporting purposes, the previous 
analysts’ results may be used to document the presence of specific cell types or body fluids. 

 
3.3.4 PCR SETUP: 
 

 Use dedicated pipettes for adding kit reagents and DNA to the PCR tubes. 
 

 Add DNA to the PCR tube last.  This practice reduces the possibility of inadvertent transfer of DNA 
between samples and kit reagents.  Only one sample tube should be open at a time during DNA 
addition. 

 

 The negative amplification control (no DNA) allows for the detection of contamination during PCR 
setup. 

 

 Avoid touching the inside surface of the tube caps. 
 

 Change pipette tips after the addition of each DNA sample. 
 

 Store the amplification kits in the designated reagent refrigerator.  Do not store them near extracted 
DNA. 
 

3.3.5  POST AMPLIFICATION ROOM: 
 

 Only disposable lab coats are to be used in the Amplified DNA Area. 
 

 The Amplified DNA Area is dedicated to amplified DNA and should not be used for pre-amplification 
purposes. 

 
 All surfaces in the Amplification Area should be cleaned with 10-20% bleach solution before and after 

setting up samples for analysis.  The floor of the Amplification Area will be mopped with a dilute bleach 
solution every two weeks. 

 

 Caution should be used when handling PCR products to minimize dispersing of the product in the 
Amplification Area. 

 

 Always remove the gloves and lab coats before exiting the Amplification Area. 
 

 Change gloves whenever contamination with PCR product is suspected. 
 

 Use disposable bench paper to cover work areas. 
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 All equipment found in the Amplification Area is dedicated to that area and will never be removed 
unless proper decontamination procedures have been employed. 
  

 Store amplified DNA in the designated amplified DNA freezer.  Under no circumstances should the 
amplified DNA be stored within the DNA Extraction Area. 

  
3.3.6 DNA INTERPRETATION 
 

 DNA interpretations must be documented in the analytical record. 
 

 CODIS sheets for evidence samples must be part of the analytical record. 
 

 
3.4 DNA SAMPLE STORAGE 

 
3.4.1 EXTRACTED DNA 
 

Extracted DNA will be stored on a short-term basis in a dedicated freezer in the DNA Extraction Area.  
DNA extracts should be stored in closed containers or sealed bags. 
 
Extracted DNA will be stored long-term frozen in the Property Room.  A new barcode number must 
be created for extracted DNA samples.  All new items in File-on-Q require an incident number to be 
assigned.  Any new incident number assigned to extracted DNA samples will follow the format of: 
“ExtDNAanalystthreeletterinitialsMMDDYY”. 

 
3.4.2 AMPLIFIED DNA 
 

Amplified DNA samples will be stored in a dedicated freezer in the Amplification Area.  Under no 
circumstances will amplified DNA be stored outside the Amplification Area.   
 
Amplified DNA samples will be maintained for a period of six months from the date of amplification.  
After this time, the amplified DNA will be discarded. Care must be taken to avoid contaminating other 
areas or evidence with amplified product. 

 
 

3.5 POLICIES REGARDING FREEZER PACKETS 
 
Freezer packets are created to store derivative evidence separated or prepared from other evidence that is 
customarily stored unfrozen.   
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Anytime a freezer packet is made for derivative evidence the following information (at minimum) should be 
clearly marked: 
 
-Incident number or Case number (if available) 
-Barcode number(s) of the evidence contained within 
 
Any derivative evidence (stains, cuttings, or swabs) that will be impounded into the Property Room as 
additional evidence will require the generation of a new item in the barcode system under the appropriate 
incident number.  Documentation of the newly generated items should be included in the case notes. 
 
When items that already have a barcode number (or a sub-designation from an existing barcode number) are 
packaged together, and the packaging is given a new barcode number for the purposes of storage, the 
barcode of the packaging is for temporary storage purposes and does not become the designator for the items 
inside. 

 
3.6 UNIQUE IDENTIFIERS 

 
General: 
 
Items stored in the Property Room or Laboratory Vault should have a unique identifier. The barcode number 
uniquely identifies each item stored in the Property Room or Laboratory Vault under the File-on-Q system.  
Items stored under the old system will be uniquely identified by the case number (or lab sequence number), 
property tag number, and item number.  Multiple items contained within a single package (e.g., the contents of 
a SART kit) should all be given a sub-item designation, which should be noted in the barcode system for that 
item.  
 
Any stains, cuttings, or swabs taken of items that will be impounded into the Property Room as additional 
evidence will require the generation of a new item in the barcode system under the appropriate incident number. 
 
All items included on a laboratory request to be examined by the laboratory (excluding internally produced 
requests) are considered evidence.  All cell pellets, extracted DNA, and amplified DNA will be considered the 
work product of the DNA laboratory. 
 
During the screening and DNA analysis of evidence it is common to have samples contained in microcentrifuge 
tubes.  These include question stains, reference samples, cell pellets being preserved for possible DNA analysis, 
and extracted DNA.  Each sample analyzed within a batch will be labeled with an identifier that will uniquely 
identify it during its analysis. Additional descriptors may be employed to identify particular samples such as “NS” 
to identify non-sperm fractions of extracts, or (Y) to denote a Y-screen extract.   
 
3.7 DISCONTINUING ANALYSIS OF SAMPLES 
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Variables, such as the existence of other probative samples, or the case scenario may affect the decision to 
discontinue the analysis of a sample.  Quantification information may provide additional insight into the 
likelihood of obtaining interpretable DNA results, and the decision to discontinue analysis may best be made 
after quantification of the sample(s). 
 
In general, analysts may discontinue analysis of samples under the following circumstances: 
 
If a sample contains insufficient DNA to reasonably obtain an interpretable DNA profile, it may be discontinued.  
An analyst may be reasonably sure that the sample has insufficient DNA to produce a full DNA profile if a large 
enough proportion of the sample has been quantified, such that, based on the estimated amount of DNA in the 
rest of the sample, amplification of the entire sample is unlikely to yield an interpretable DNA profile. 
Discontinuation of samples is dependent on circumstances of the case, as sometimes even limited information 
may be beneficial to the investigator(s). 
 
The intent of this policy is to be able to discontinue analysis on single samples from items/cases that are unlikely 
have enough DNA to obtain a DNA profile.  In cases where multiple samples from the same item are collected 
for the same purpose (e.g. DNA sample collected from two different areas on a shirt for wearer information), if 
one sample has sufficient DNA additional samples collected for the same purpose may be discontinued. 
 
Touch/Wearer DNA Evidence 
If the amount of total DNA in the extract is less than or equal to ≤0.0005ng/uL, the samples are unlikely to yield 
interpretable DNA results with the GlobalFiler amplification kit and the sample may be discontinued. 
 
Child Abuse Cases 
Prior to discontinuing analysis on Child Abuse cases, the most potentially probative evidence item(s) negative for 
male DNA require microscopic examination to confirm no semen is present. 
 
Sexual Assault Cases 
Given the correlation between the amount of DNA in a sample and the likelihood of obtaining interpretable 
DNA, the decision to discontinue analysis may best be made after quantification of the samples. 

 
If the sperm fraction is probative, it should contain a detectable amount of male DNA to proceed with DNA 
analysis.  If the sperm fraction is being typed, the associated non-sperm fraction can be discontinued if no 
male DNA is detected.   
 
If the non-sperm fraction is probative and male DNA is detected in the sperm fraction, both the sperm and 
non-sperm fractions must be DNA typed.   
 
If the non-sperm fraction is probative and no male DNA is detected in the sperm fraction, only the non-
sperm fraction needs to be DNA typed. 
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If no male DNA is detected in the sperm fraction and the non-sperm fraction has no male DNA or a ratio of 
human:male DNA greater than 75:1, the analysis of both fractions can be discontinued. 

 
Firearms Evidence 
Swabs from firearms generally have multiple swabs for handler DNA including both “before” and “after” 
processing swabs.  If all swabs have insufficient levels of DNA to reasonably obtain an interpretable DNA profile, 
the swabs will be combined for DNA analysis. 
 
 
3.8 INSTRUCTIONS FOR PROCESSING FIREARMS FOR DNA 

 
3.8.1 DNA TESTING FIRST  
 
The Forensic Biology Unit may process guns for DNA prior to latent print processing.  In this instance the 
textured areas of the firearms such as grips, slide, magazine release, safety, trigger, hammer, cylinder 
release, and slide lock(s) will be swabbed.   Smooth areas will be preserved for fingerprint processing. 
 
A sticker will be placed on the packaging indicating that swabbing for potential DNA evidence has been 
done. 
 
  
3.8.2 FINGERPRINT PROCESSING FIRST 

 
In instances where the majority of the firearm has smooth surfaces, the Crime Scene Unit will process the 
firearm prior to swabbing for potential DNA evidence.   
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4.0  CODIS 
 
The Combined DNA Index System (CODIS) is a nationwide forensic DNA database managed by the FBI.  It consists 
of DNA databases at the local (LDIS), state (SDIS), and national (NDIS) levels.  The purpose of CODIS is to develop 
investigative leads by matching DNA profiles of two or more samples from these various categories. The database 
primarily consists of casework evidence profiles and convicted offender profiles.  Sample categories include Forensic 
Unknowns (single source profiles), Forensic Partials (single source, but partial profiles), Forensic Mixtures, 
Convicted Offenders, Arrestees, Suspects, Unidentified Human Remains, Missing Persons, and Relatives of Missing 
Persons.   
 
The CODIS software searches for genotypes that are represented by the list of alleles uploaded at each locus.  Not all 
genotypes represented by the listed alleles may be accepted based on the interpretation of the evidence.  For 
example, if four alleles at a locus are submitted to CODIS from a 2-person mixture, the search will return hits against 
any homozygote genotype represented by the listed alleles.  Based on the interpretation of a 2-person mixture, any 
homozygote genotype would be excluded as a possible contributor, even though CODIS would return a hit to it. The 
case analysts are responsible for determining what is being searched in CODIS in their assigned cases and what 
genotypes would be acceptable at each locus.   
 
Consultation with the CODIS Administrator for searches of complex mixtures is encouraged.  If the CODIS 
Administrator is consulted, documentation of the consultation will be made on the CODIS sheet; however, the 
technical reviewer is still mandated to assess the types and the sample itself as being acceptable for CODIS.  Technical 
reviewers will document this review by initialing and dating the CODIS sheet.  Any material changes made to the 
CODIS sheet as a result of the technical review must be documented. Any material changes made by the CODIS 
Administrator after technical review is complete must be discussed with case analyst and documented within the 
analytical record. 
 

4.1 ENTRY OF DNA PROFILES INTO CODIS 
 

The SDPD Forensic Biology Unit’s procedures for the entry of DNA profiles into CODIS are based upon the 
guidelines outlined in the NDIS Procedures and the California Penal Code.   
 
Many different situations may be encountered in forensic casework that will influence which DNA profiles, or 
what portion of a DNA profile, are acceptable for entry into CODIS.  The following are meant as guidelines and 
do not cover every possible scenario. 

  

 DNA profiles selected for entry into CODIS are submitted on forms referred to as CODIS sheets.  These 
must be technically reviewed to ensure accuracy of the DNA types and specimen category, and acceptability 
for CODIS entry. If multiple items from the same case have the same DNA profile, only one CODIS sheet 
should be used. 
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 Forensic mixture and forensic partial DNA records submitted to NDIS shall be reviewed to ensure the DNA 
records satisfy a statistical threshold for match rarity of approximately one in the size of the NDIS database. 

 DNA profiles (single source or mixtures) from possible perpetrators derived from evidence should be 
entered into CODIS, unless that evidence was collected from a suspect.  In addition to the general eligibility 
requirements for DNA profiles outlined by NDIS guidelines, the suitability of any given DNA profile for 
submission to the various levels of CODIS is generally dependent on the discrimination power of the DNA 
profile as compared to the number of DNA profiles contained within the given database. 

 DNA profiles or portions of DNA mixtures attributable to victims or elimination reference samples 
(boyfriend, husband, etc.) should not be entered into CODIS.  Forensic profiles that are ultimately linked to 
consensual partners will be removed from the database. 

 CODIS sheets should be filled out for suspects that were not matched to an evidence sample or that were 
included as possible contributors to a DNA mixture (see section 4.2 for additional information on suspect 
DNA profiles).  These profiles are considered “Suspect Known” DNA profiles.  DNA profile information 
will be entered into the local CODIS database (LDIS), also known as the SDPD’s local DNA database, for 
any suspect (or possible suspect) sample submitted for DNA analysis.  These DNA profiles will be 
maintained indefinitely within LDIS. 

 Upon confirmation of their status as a suspect by the submitting detective, “Suspect Known” DNA profiles 
will be uploaded to the State CODIS Database (SDIS).  Suspect Known DNA profiles will remain at SDIS for 
as long as they are permitted under SDIS regulations. 

 In general, CODIS sheets will be removed from the case file during the administrative review and given to 
the CODIS Administrator for entry.  Copies of CODIS sheets must be retained within the analytical record 
as numbered pages. 

 CODIS profiles will be reviewed for eligibility, correct DNA types, and appropriate specimen category 
prior to upload or search of SDIS. 

 Searches of profiles in the local DNA database may be done prior to technical review of the case file. 
 
 

4.2 UPLOADING SUSPECT DNA PROFILES  
 

The passage of Proposition 69 in 2004 allows DNA profiles from suspects to be entered into the California State 
CODIS database so long as the individual remains a viable suspect in the case for which their sample was 
submitted.  The proposition states that DNA profiles from suspects must be removed from the State CODIS 
database after two years unless written documentation that the individual is still a suspect is received by the State 
CODIS Administrator from the agency submitting the suspect DNA profile.  Written documentation must be 
submitted to the State CODIS Administrator every two years for a suspect profile to remain in the State CODIS 
Database.  The SDPD laboratory will remove suspect DNA profiles from the State CODIS Database when a 
profile has been in the State CODIS Database for a period of two years.  Should a suspect with their profile 
entered into the State CODIS Database be eliminated as a suspect in the case for which their sample was 
submitted, the DNA profile from that individual will be removed from the State CODIS Database. 
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No DNA profiles obtained from juveniles (i.e., under the age of 18 at the time of collection) will be stored in the 
local CODIS database. 
 
Procedure for Uploading ADULT Suspect DNA Profiles from the SDPD’s Local DNA Database 
 
Only DNA profiles generated from adult suspects who are (1) arrested for a felony, (2) subject to conditions 
associated with fourth waiver status, (3) mandated by a court order to provide a DNA sample, or (4) consent to 
the collection of their DNA by signing a SDPD Consent Form will be entered into the Local CODIS Database. 
 
Procedure for Uploading/Removing Suspect DNA Profiles from the State CODIS Database 
 
1. For each suspect DNA profile entered into the SDPD’s local DNA database a form letter will be sent to the 

case detective.  This letter requests the detective indicate whether or not the person in still considered to be 
an active suspect in the investigation. 

2. If the detective indicates that the person is considered to be an active suspect, the suspect’s DNA profile is 
uploaded to the State CODIS Database. 

3. After two years the suspect’s DNA profile is removed from the State CODIS Database. 
4. Form letters documenting active suspect status will be maintained for the duration of the profile remaining 

in the State CODIS Database. 
 

 
4.3 DATABASE SEARCHES AND MATCHES 

 
Searches of the SDPD’s local DNA database can occur prior to technical review and are also performed at the 
time of the entry of the profile into CODIS.  Searches of the state database are performed by the state (California 
Department of Justice).  Searches of the national database are performed by the (FBI) laboratories.  DNA profiles 
are uploaded to the state database at least once a week to coincide with database searches and with the uploading 
of DNA profiles from state to national databases. 
 
Periodically, information contained within the SDPD’s local DNA database (SDPD’s LDIS) may be shared with 
accredited forensic DNA laboratories in other jurisdictions. Similarly, information from the LDIS of accredited 
laboratories from other jurisdictions may periodically be shared with our laboratory.  In these instances, a “batch 
file” containing the information within LDIS will be provided for the purpose of comparing DNA profile 
information between jurisdictions.  When the SDPD Crime Laboratory receives a batch file from another 
agency, the batch file is used for a search against LDIS.  The data from the external agency is not stored with the 
SDPD’s LDIS and ownership of the data is retained by the agency from which it originated.  It is the 
understanding of our laboratory that outside agencies will take the same approach with our LDIS information. 
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There are two basic types of database matches that could provide an investigative lead: forensic hits and offender 
hits.  Forensic hits involve the matching of Forensic Unknowns from two cases.  Offender hits involve the 
matching of a Forensic Unknown to a Convicted Offender. 
 
Any potential database matches will be evaluated by the CODIS Administrator (or designee).  In general, if the 
SDPD sample matching in CODIS is from an unknown source, the match will be evaluated for “goodness of fit”.  
If the potential match is deemed to be good, at that time the notification process will be allowed to proceed. 
 
The “goodness of fit” of any potential database match will be dependent on the specimen category. In general, 
potential matches between forensic unknowns and any sample in a single source sample index (e.g., convicted 
offender) will be assessed visually. Potential matches between a mixture or partial DNA profile and any sample 
in a single source sample index will be assessed through a likelihood ratio. The likelihood ratio will generally 
assess the probability of the evidence given the DNA profile from the putative match is a component of the 
mixed or partial DNA profile searched against the probability of the evidence given the DNA profile from the 
putative match is not in the mixed or partial DNA profile searched. In general, the likelihood ratio results used 
for the assessment will be the lowest 99% 1-sided HPD value for the four population groups. Likelihood ratio 
results greater than fifty times the size of the relevant database in these comparisons will be declared as offender 
or forensic hits. Likelihood ratio results between ten and fifty times the size of the relevant database will be 
further reviewed to determine if the putative associations will be reported. The likelihood ratio results used to 
assess forensic and offender hits will be retained electronically (G:\Misc DATA\CODIS\CODIS Matches). If 
the database LR results are sufficiently high (1.0x1011 or greater), it may not be necessary to perform an LR with 
HPD calculation as the value considering the HPD is unlikely to be less than the likelihood ratio threshold.  
 
The matching of two evidence samples known or suspected to be from the same person is referred to as a 
benchwork match.  When an evidence sample has already been linked to a suspect and then matches the same 
person who is in the database as a Convicted Offender sample, this is referred to as a conviction match. 
 
Information regarding forensic and offender hits must be included in at least one report.   Prior to a match report 
being written, investigators may be contacted regarding DNA matches.  However, care must be taken to 
communicate the information accurately, and any significant communication should be documented on a 
communication log. Prior to releasing the information to an investigator, the results should be reviewed by a 
second analyst and the review documented in the notes. 

 
 

4.4 MAINTENANCE OF A STAFF INDEX IN CODIS: SAMPLES FROM LABORATORY EMPLOYEES 
AND INTERNS 

 
Section 2.9 in the Quality Assurance Manual addresses this database. The following are the rules for the 
collection and analysis of these samples: 
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1. A SDPD Reference Mouth Swab Kit will be used to collect two swabs from the individual.  The Quality 
Assurance Manager will coordinate sample collection and coding of the sample. 

2. SDPD Reference Mouth Swab Kits from Staff and Interns for which permission to retain has been obtained 
will be archived with the Quality Assurance Manager. 

3. The samples to be analyzed by a qualified DNA analyst following the protocol used to analyze reference 
mouth swabs in casework. 

4. The DNA Technical Manager or CODIS Manager will review the analysis and enter the DNA profiles in the 
Staff Index of the SDPD’s local DNA database. 

5. The electropherograms and CODIS printout will be maintained for each sample. 
 
 

4.5 REPORTING DNA RESULTS ASSOCIATED TO THE ELIMINATION DATABASE. 
 

When an evidence DNA profile is found to match or potentially be associated with a profile in the elimination 
database, the following will be done: 
 
The CODIS match detail report, or first page of the STRmix Database Search report indicating the match to the 
coded sample from the elimination database will be included in the analytical record. 
 
If the DNA profile in the case was found to match (or the mixture includes) DNA from any elimination profile in 
the database, the report will state DNA from staff was found to be associated with the DNA profile in the case.  
The report will also address whether any interpretations were affected by the presence of this DNA. 
 
A Staff Match Summary Sheet will be completed detailing the match and will include the coded sample number 
from the elimination database that matched to the evidence.   
 
The Staff Match Summary Sheet will be submitted to the DNA Technical Manager and will be routed through the 
Quality Assurance Manager.  For any association where the HPD LR is above the limited support category, the 
Quality Assurance Manager will conduct further inquiry into the root cause of the contamination. 
 
4.6 OUTSOURCING 

 
In order for the SDPD Crime Laboratory to accept outsourced data for the purposes of searching the CODIS 
databases the following criteria must be met prior to the initiation of analysis by the vendor laboratory: 

 

 The vendor lab selected for the analytical testing must be accredited and the documentation of that 
accreditation, including the vendor laboratory’s latest external audit report including responses and follow-
up must be provided to the SDPD Crime Laboratory. 

 Prior approval by the DNA Technical Manager of the technical specifications of any DNA analysis to be 
performed by the vendor laboratory is required. 
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 For any new outsourcing agreement an on-site visit to the vendor laboratory by the DNA Technical 
Manager, or another qualified analyst, is required. 

 
 

4.6.1 ON-SITE VISITS TO VENDOR LABORATORIES 
 

For any new outsourcing agreement, the DNA Technical Manager, or another qualified (or previously 
qualified) analyst designated by the DNA Technical Manager or Supervising Criminalist, will perform an on-
site visit of a vendor lab prior to the initiation of analysis on the outsourced samples.   
 
An on-site visit to a vendor laboratory shall include at a minimum: 
 

 An evaluation of the laboratory facilities to ensure the integrity of the evidence will be maintained while in 
the custody of the vendor lab. 

 An evaluation of the procedures as they relate to ensuring minimal loss or contamination of the evidence 
while in the custody of the vendor lab. 

 An evaluation of any Corrective Actions taken by the laboratory in the previous six months prior to the 
on-site visit. 

 An interview with the vendor laboratory’s DNA Technical Manager or laboratory analyst. 
 
The on-site visit will be documented in a report that will be maintained by the DNA Technical Manager. 
 
If an outsourcing agreement with a vendor lab is continued from one year to the next, then an on-site visit to 
the vendor laboratory by another NDIS participating laboratory using the same  technology, platform, and 
typing test kit may be used.  Documentation of the on-site visit by a second NDIS participating laboratory must 
be obtained by the SDPD Crime Laboratory before any new analysis is initiated in the new year of the 
agreement. 

 
4.6.2 REVIEW OF OUTSOURCED DATA 

 
Prior to uploading outsourced data into the databases of the Combined DNA Index System (CODIS) a 
technical review of the data will be performed.  The review of the data will be performed by a qualified (or 
previously qualified) DNA analyst and will be documented and include: 
 

 A review of the analytical record to include all controls (ladders, positive and negative amplification 
controls, and blanks. 

 A review of the vendor laboratory’s final report to ensure that the results/conclusions are supported by 
the data, and that each tested item (or its probative fraction) is addressed. 

 A review of the data for all submitted samples to the vendor laboratory. 
 A verification of the DNA types, eligibility, and correct specimen category of any sample to be uploaded 

to the CODIS databases. 
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4.7 REINTERPRETATION OF LEGACY AMPLIFICATION KIT DATA 

According to the FBI Director’s Quality Assurance Standards for DNA Testing Laboratories standard 13 states, an 
analyst can only interpret data generated by the amplification test kit in which he or she is currently proficiency 
tested, therefore if the analyst is not currently proficiency tested in an amplification test kit previously used by 
the laboratory (i.e., a legacy amplification kit), the analyst cannot reinterpret the legacy data.  

This policy is intended for situations when an analyst is required to reinterpret data generated with legacy 
amplification test kits for a comparison made to DNA profiles generated with amplification test kits in current 
use. 

Reinterpretation of legacy data may occur in accordance with the following: 

1. If an analyst is currently qualified in an amplification test kit (trained and proficiency tested), and the 
analyst was previously qualified (trained and proficiency tested) in the legacy amplification test kit, 
the analyst can reinterpret the legacy data if the analyst has been proficiency tested on the legacy test 
kit within the last two calendar years. If an analyst has not been proficiency tested on a legacy test kit 
within the last two calendar years, then the Technical Leader must document and approve the 
completion of the analyst’s review of the validation data and standard operating procedures of the 
legacy test kit. If an analyst, who has completed the requirements to interpret legacy amplification 
test kit data, has not reviewed the required documents within the last two calendar years, the 
Technical Leader must document and approve the completion of the analyst’s additional review. 

 
2. If an analyst is currently qualified in an amplification test kit (trained and proficiency tested), but has 

never been previously qualified in the legacy amplification test kit, the analyst can reinterpret the 
legacy amplification test kit data if the analyst is trained in the legacy test kit interpretation protocols 
by a previously qualified analyst. The review of the validation data and standard operating procedures 
of the legacy test kit, training by the previously qualified analyst, and interpretation competency test 
must be completed by the analyst, and documented and approved by the Technical Leader. 
Documentation shall contain sufficient information for an auditor to confirm the analyst is qualified to 
reinterpret legacy amplification test kit data.  
 

3. If a previously qualified analyst is unavailable to train a currently qualified analyst on a legacy 
amplification test kit, it is highly recommended that the current analyst not reinterpret legacy data. 
However, if the current analyst must perform legacy interpretation without training from a 
previously qualified analyst, then it is recommended that the currently qualified analyst and Technical 
Leader train in the legacy test kit interpretation protocols, review validation data and standard 
operating procedures. The training and interpretation competency test must be completed by the 
analyst, and documented and approved by the Technical Leader. Documentation shall contain 
sufficient information for an auditor to confirm the analyst is qualified to reinterpret legacy 
amplification test kit data. 

 
4. If a laboratory generates new interpretation protocols from legacy validation data (e.g., developing a 

stochastic threshold when none previously existed), the laboratory shall document the basis for the 
new interpretation protocols. These new protocols shall be documented in the laboratory’s standard 
operating procedures and memorialized in the Quality Assurance Standards Audit Document. The 
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training and interpretation competency test must also be completed by the analyst, and documented 
and approved by the Technical Leader. Documentation shall contain sufficient information for an 
auditor to confirm the analyst is qualified to reinterpret legacy amplification test kit data.  

Technical reviewers of reinterpretations of the legacy data are held to the same training requirements as the 
analyst reinterpreting the data. 
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5.0  LABORATORY MAINTENANCE 
 

5.1 GENERAL LABORATORY MAINTENANCE 
 
All members of the Forensic Biology Unit are responsible for the general upkeep of the laboratory including 
stocking supplies, washing dishes, and cleaning common areas.  Protective gloves, safety goggles, and a 
laboratory coat should be worn when handling chemicals and cleaning lab instruments.  The following tasks are 
completed each week: 
 
 Monitor the operating temperatures of all freezers, refrigerators, and incubators.  Log temperatures on the 

log sheets.  When a sheet has been completed, it should be scanned into the FB network and moved to the 
appropriate folder within the QA-QC folder.  The scanned sheet should be saved using a file name that 
clearly indicates what the log is for. 
 

 Wipe general use counters with 10-20% bleach solution. 
 

 Clean common use centrifuges with 10-20% bleach solution followed by wiping with distilled water. 
 

 Wipe hoods with 10-20% bleach solution (do not wipe plastic doors). 
 

 Clean interior and exterior of drying boxes with 10-20% bleach solution. 
 

 Wash glassware and dishes not belonging to an analyst (analysts are responsible for their own dishes).  
Return washed dishes to their appropriate storage location. 
 

 Fill distilled water carboys, reagent alcohol bottles, 10-20% bleach solution bottles, and Liquinox detergent 
bottles. 

 
The above tasks apply to all rooms of the Forensic Biology Unit.  Every two weeks, the Amplification Room 
floor will be mopped with 10-20% bleach solution.  Record the completion of maintenance tasks in the Main 
Forensic Biology Unit Maintenance Log, and Amplification Room Maintenance Log. 

5.1.1  Glassware Washing 
 

It is the responsibility of each analyst to wash their own dishes.  Protective gloves, safety glasses, and a lab coat 
or apron should be worn.   
 
1. Wash glassware in warm water with Liquinox detergent. 

 
2. Rinse detergent from glassware by rinsing in tap water. 

 
3. Rinse each piece of glassware in distilled water. 
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4. Set glassware to dry. 
 

5. Return glassware to appropriate storage location when dry. 
 
Note:  The most critical concern about glassware in the DNA Laboratory is that glassware in the Amplification 
room and glassware from the DNA Extraction-PCR Setup Area be kept separate.  The use of glassware 
dedicated to the Amplification area in the DNA Extraction-PCR Setup area is far more serious than the 
reverse.  The only circumstance in which glassware may be transferred from the Amplification Room to the 
DNA Extraction-PCR Setup Area is if the glassware has been treated with bleach for 30 minutes followed by 
autoclaving. 

 
 

5.2 CLEANING LOGS 
 

The following cleaning logs will be maintained by the Forensic Biology Unit.  They are intended to ensure 
common use areas are kept in a clean state.  Any cleaning should be entered electronically into the FB cleaning 
log excel workbook.  

 

Cleaning Log Location Updated 

Forensic Biology Main Lab Electronic Weekly 

Amplification Room Electronic Weekly/ Biweekly (floors) 

Qiagen BioRobot® EZ1 Electronic Monthly 

 
 

5.3 CLEANING AND DECONTAMINATION PROCEDURES 
 

Squirt bottles containing a dilute bleach solution (10-20%) are present in the different work areas in the DNA 
Laboratory.  Following DNA extraction, PCR setup, or preparation of amplified DNA samples the work areas 
that were utilized will be thoroughly washed with the bleach solution making sure the entire work areas are 
treated. 
 
If lab bench paper has been laid down and is thought to be contaminated with DNA, the lab bench paper should 
be disposed of. 
 
Racks or glassware thought to be contaminated with amplified DNA will be treated in the manner described 
below. 
 
For items that cannot be autoclaved, they will be soaked in 20% bleach for 30 minutes, rinsed thoroughly with 
tap water, rinsed in distilled water, and allowed to air dry. 
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For items that can be autoclaved, they will be treated first with bleach as previously described and then 
autoclaved for thirty minutes. 

 
5.3.1 DECONTAMINATION OF CENTRIFUGES 

 
In general, any removable part of a centrifuge can be cleaned with detergent and water, rinsed with distilled 
water, and allowed to dry. If a serious contamination problem occurs (i.e. spilled extracted or purified DNA), 
the rotor should be rinsed in a 10-20% bleach solution, rinsed with distilled water, and allowed to dry. 
 
The metal tubes used with the Sorvall centrifuge should be cleaned with detergent and water after each use.  
The metal rotors and tubes the Sorvall centrifuge can also be autoclaved. 
 

 
5.4 DISPOSAL OF HAZARDOUS WASTE 

 
There are six waste streams within the Forensic Biology Unit that should be handled as hazardous waste.  
These are as follows: 
 

5.4.1 PHENOLPHTHALIN CONTAMINATED SWABS 
Phenolphthalin contains ethanol and swabs contaminated with it will go into appropriately 
labeled waste buckets.  After the swabs have dried the swabs can be disposed of in the 
regular trash. 
 

5.4.2 PHENOLPHTHALIN AND LMG LIQUID WASTE  
Phenolphthalin and LMG liquid waste contains zinc; a heavy metal.  The unusable liquid 
waste will be stored in the Chemical Storeroom for disposal.  The bottles should be 
appropriately labeled with the hazard (flammable for pheno and corrosive for LMG).  The 
zinc contained in both reagents should also be noted on the log. 

 
5.4.3 QIAGEN REAGENT WASTE (EZ1 or QiaSymphony) 

EZ1 strips are flammable because of the ethanol they contain and should be placed in the 
designated waste containers by the instruments.  All tips, tip holders, and tubes can be 
disposed of as regular trash.  When the EZ1 strip waste containers are full the waste can be 
transferred to the Chemical Storeroom for disposal. Liquid QiaSymphony waste can also be 
transferred to the Chemical Storeroom. 

 
 

5.4.4 FORMAMIDE WASTE 
Formamide is a known teratogen and the formamide waste will be disposed of in the waste 
bucket in the amplification room.  When full the waste can be transferred to the Chemical 
Storeroom for disposal. 
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5.4.5 BIOHAZARDOUS WASTE 
Large volumes of liquid blood are biohazardous.  Any large volumes of blood and the 
materials used to clean them up should be disposed of in red biohazard containers. 

 
5.4.6 NON-HAZARDOUS WASTE 

Small volumes of blood that will dry within a reasonable amount of time can be disposed of in the 
regular trash.  LMG test swabs can be disposed of in the regular trash.  All plasticware [tips, tubes 
(including microcon/centricon tubes), transfer pipets, etc] and gloves can be disposed of in the 
regular trash.  Acid phosphatase test swabs can be disposed of in the regular trash and any waste liquid 
down the drain. 
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6.0  EQUIPMENT MAINTENANCE PROTOCOLS 
 

6.1 USE AND MAINTENANCE OF THE WATER SYSTEM 
 

The ultra/nano pure system uses the distilled water reservoir as its water source.   
 

Ultra pure water 
The Barnstead NANOpure ultra pure water system removes ions from water.  It is meant to be used with 
pretreated water.  Hence, the water used is first distilled.  The system can be set to three different modes: off, 
standby, and on.  The system is left on standby when not actively in use to allow water to be circulated 
through the cartridges for five minutes out of every hour.  This extends the life of the cartridges.  When ultra 
pure water is needed, set the system to the on mode by pressing the ‘ON/STANDBY/OFF’ button until a 
numerical value appears.  This number represents a resistivity measurement of the water, which indicates its 
purity.  Wait for the number to increase to at least 18.0 before dispensing.  If this number remains below 
18.0, then the cartridge is no longer efficiently deionizing the water.  A carboy is used to collect and store 
ultra pure water, as the system produces purified water rather slowly.  The ultra pure water system should 
never be used when the distilled water reservoir is empty.  A low water protection device has been built into 
the distilled water reservoir to prevent the ultra pure water system from operating when the still is low. 

 
 

6.2 OPERATION OF THE pH METER 
 

Thermo Scientific Orion Star A111 pH Meter Operation 
 
Electrode Preparation 
1. Disconnect electrode from meter. 
2. Uncover the filling hole and add electrode filling Ag/AgCl solution. 
3. Solution must be above reference junction and at least one inch above sample level. 
4. The filling hole must be open when electrode is in use and closed when in storage. 
5. Place the electrode in the electrode holder and suspend it in air for 5 minutes so that the solution in the 

electrode can thoroughly wet the reference junction. 
6. Shake electrode downward (similar to a thermometer) to remove air bubbles. 
7. Soak electrode in pH electrode storage solution for 30 to 60 minutes. 
8. Connect electrode to meter. 
 
Electrode Storage 
1. Short-term Storage (up to one week) 

a. Soak the electrode in pH electrode storage solution. 
b. To prevent crystallization of the fill solution, cover the fill hole whenever the electrode is being stored and 

open the fill hole when calibrating and measuring. 
2. Long-term Storage (more than one week) 

a. Fill the reference chamber and securely cover the filling hole. 
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b. Cover the sensing element and reference junction with the protective cap/sleeve containing a few drops 
of storage solution. 

c. Before returning the electrode to use, prepare it as a new electrode. 
 
Electrode Maintenance 
1. Inspect the electrode for scratches, cracks, salt crystals. 
2. Rinse off salt crystals with DI water. 
3. Drain the reference chamber, flush it with fresh filling solution and refill the chamber with fresh filling 

solution. 
 
Electrode Cleaning 
1. Soak electrode in 0.1 M HCL or HNO3 for 30 min. 

a. Can also be soaked in a 1:10 dilution of household bleach mixed with hot water (stir at fast rate). 
2. Drain the reference chamber and refill it with fresh filling solution. 
3. Soak the electrode in pH electrode storage solution for at least 1 hour. 
 
Calibration 
1. Prepare the electrode according to the electrode preparation instructions. 
2. Connect the probe to the meter and turn on the meter. 
3. Press mode to display pH for the pH measurement mode. 
4. Select 2 pH buffers that bracket the pH you are targeting. 
5. Press Cal 
6. Rinse the electrode in DI water and blot with a kim wipe. 
7. Place electrode into first buffer. 
8. Wait for “Ready” then record value in log book. 
9. Rinse the electrode in DI water and blot with a kim wipe. 
10. Place electrode into second buffer. 
11. Wait for “Ready” then record value in log book. 
12. Rinse the electrode in DI water and blot with a kim wipe. 
 
Measurement 
1. Perform Calibration steps first. 
2. Make sure it is in pH measurement mode. 
3. Press measure: the meter will immediately start taking readings. 
4. When “Ready” is displayed the meter stops measuring the pH, so you may need to press measure 

multiple times when pH-ing the solution. 
5. When you reach the target pH rinse the electrode in DI water and blot with a kim wipe.  
6. Turn pH meter off. 
Store electrode according to the Electrode Storage directions provided. 

 

6.3 OPERATION OF THE AUTOCLAVE 
 

The autoclave is used to sterilize critical reagents and equipment via steam pressurization.  There are two exhaust 
selector settings on the autoclave:  FAST (Instruments) and SLOW (Liquids).  Use the slow setting when only 
liquids or liquids and equipment are being sterilized.  If sterilizing equipment use the fast setting. 
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1. Close the drain valve. 
2. Fill with autoclave with approximately 5.5 liters distilled water and 0.5 liters tap water. 
3. Load autoclave with items to be sterilized.  Place autoclave tape on lids, if necessary, and be sure lids are on 

loosely. 
4. Close autoclave door.  Be sure the door closes tightly.  If not, adjust the screw below the door handle latch. 
5. Set the exhaust selector to “Fast or Slow”, depending on the items being sterilized. 
6. Set the time for 30 minutes. 
7. When the sterilization is complete, carefully open the door and drain valve.  Do not open the autoclave 

immediately after sterilization is complete due to the high heat and pressure; allow to cool and depressurize. 
 
 

6.4 BALANCES 
 

Balances and microscopes in the Forensic Biology Unit will be maintained and the calibration checked according 
to policies outlined in the laboratory Quality Assurance Manual.  Laboratory balances are calibrated by an outside 
company once a year.   
 
The calibration is checked every three months by the Laboratory Technician.  Balance calibration is checked by 
weighing various NSB certified weights, given in the tables below.  The acceptable range of variation is 1% from 
the true value for weights less than one gram, and 5% from true value for weights greater than one gram.   
 
If a balance is found to be out of calibration, it has to be sent to an outside company to be recalibrated.  Once 
returned, the calibration of the balance will checked by the Laboratory Technician before use in the laboratory. 

 

Analytical Balance 

Weight (g) Acceptable Range (g) 

0.01 0.0099 - 0.0101  

0.05 0.0495-0.0505 

0.10 0.0990-.0.1010 

0.50 0.4950-0.5050 

1.00 0.9500-1.0500 

5.00 4.7500-5.2500 

10.00 9.5000-1.0500 

50.00 47.5000-52.5000 

100.00 95.0000-105.0000 

 
 

Pan Balance 

Weight (g) Acceptable Range 
(g) 

1.00 0.95-1.05 

5.00 4.75-5.25 

10.00 9.50-10.50 

50.00 47.50-52.50 

100.00 95.00-105.00 

200.00 190.00-210.00 
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6.5 MAINTENANCE OF THE QIAGEN EZ1s 
 

Each month the piercing units are cleaned and the O-rings are greased on the Qiagen EZ1 robots.  Maintenance 
actions are recorded on the Qiagen EZ1 Maintenance Worksheet in the Qiagen EZ1 Maintenance Log.  A 
volume test is conducted every six months to monitor the pipetting accuracy of the robots.  Results of the 
volume test are recorded on the BioRobot EZ1 Volume Test Worksheet in the Qiagen EZ1 Maintenance Log. 
 

6.5.1 CLEANING THE PIERCING UNIT: 
 
The piercing unit cleaning protocol can be accessed using either the DNA Investigator Card or the Volume 
Test Card.  If only a cleaning is required, use the DNA Investigator Card; if a volume test is also due, then use 
the Volume Test card.  This will limit the number of times the machine is turned on and off and cards are 
switched.  Never remove or insert a card when the machine is on.  The DNA Investigator Card 
should always be in the machine so that it ready for use. 

 
1. With the robot off, insert the Volume Test Card or ensure that the DNA Investigator Card is in the card 

slot. 
 
2. With the door closed, turn the machine on. 
 
3. Press 1. Protocols. 
 
4. Press 3. Clean piercing unit.  The piercing unit will move forward and downward. 
 
5. Open the door by lifting up, and clean the piercing unit with reagent alcohol. 
 
6. Close the door and press Esc when finished. 

 
6.5.2 GREASING THE O-RINGS: 

 
Apply a small amount of silicon grease to the top of a filter tip and use it to apply the grease to the tip adapters.  
Wipe off any excess grease with a tissue. 

 
6.5.3 VOLUME TEST: 

 
The volume test requires the use of the Volume Test Card. 

  
1. With the machine turned off, insert the Volume Test Card. 

 
2. For each robot to be tested, individually number and weigh six empty elution tubes with caps.  Record the 

weight of the empty elution tubes on the BioRobot EZ1 Volume Test Worksheet in the Qiagen EZ1 
Maintenance Log. 
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3. Place the six empty elution tubes, without their caps, in row 1. 

 
4. Place six sample tubes containing 1mL of distilled water in row 4. 

 
5. Place six tips in tip holders in row 2. 

 
6. With the door closed, turn the machine on. 

 
7. Press the Start button.  The volume test will begin. 

 
8. When the test is complete, press Esc to exit the protocol and turn the machine off. 

 
9. Remove the Volume Test Card and insert the DNA Investigator Card. 

 
10. Replace the caps on the elution tubes and remove them from the machine. 

 
11. Weigh each tube, now filled with approximately 500 μL of distilled water. 

 
Record the weights of the water on the Volume Test Worksheet and calculate the variance.  Allowable 
variance is within 5% of the volume pipetted.  For the 500μL pipetted in the volume test, the allowable range 
is 474 to 525 μL.  Recall that 500μL is equal to 500mg. 
 
 

6.6 HAMILTON NIMBUS 4 MAINTENANCE  
 

The Nimbus requires routine maintenance to be performed daily, weekly, and semi-annually in order to ensure 
optimal performance.  Any maintenance failures should be reported to Hamilton Technical Support (1-800-648-
5950) for troubleshooting assistance. 
Daily Maintenance: 
 
The daily maintenance should be performed prior to the first run of the day.  It is not necessary to perform the 
daily maintenance prior to subsequent runs if it has already been performed on a given day.  It is also not 
necessary to perform the daily maintenance on days the Nimbus is not used. 
 
1. Power on the Nimbus instrument and attached computer. 
 
2. Open the Maintenance software (on the desktop). 
 
3. Select the “Daily” maintenance type and click “Run Maintenance”. 
 
4. Inspect deck and carriers for cleanliness. 
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a. Clean the deck with deionized water and/or ethanol. 
b. Wipe the o-rings on the channels with deionized water. 
c. Check the “Inspect deck and carriers for cleanliness” box. 

 
5. Empty Tip Waste/Liquid Waste. 

a. Remove the tip waste receptacle and empty tips into trash. 
b. Replace plastic trash bag in tip waste receptacle if needed. 
c. There is no liquid waste to empty. 
d. Check the “Empty Tip Waste/Liquid Waste” box. 

 
6. Select the “Check tightness of Pipetting Channels” box. 

a. Read the message that appears, remove the tip eject plate, close the door, and click “Continue”. 
b. The system will automatically test the o-ring seals of the channels. 

 
7. Select the “Check LLD” box. 

a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and 
click “Continue”. 

b. The system will automatically test liquid level sensing. 
 
8. Click “OK” to acknowledge that the maintenance has completed successfully. 
 
9. Replace the tip eject plate. 
 
10. Click “Close”. 
 
11. Exit the Maintenance software. 
 
Weekly Maintenance: 
 
The weekly maintenance should be performed once a week regardless of whether or not the Nimbus is to be 

used that week. 
 
1. Power on the Nimbus instrument and attached computer. 
 
2. Open the Maintenance software (on the desktop). 
 
3. Select the “Weekly” maintenance type and click “Run Maintenance”. 
 
4. Clean deck and carriers. 

a. Clean the deck with deionized water and/or ethanol. 
b. Check the “Clean deck and carriers” box. 

 
5. Check condition of carriers and other devices. 

a. Visually inspect the instrument for any obvious signs of damage. 
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b. Clean the pedestals and racks with water and/or ethanol. 
c. Check the “Check condition of carriers and other devices” box. 

 
6. Empty and clean Tip Waste/Liquid Waste. 

a. Remove the tip waste receptacle and empty tips into trash. 
b. Replace plastic trash bag in tip waste receptacle if needed. 
c. There is no liquid waste to empty. 
d. Clean the tip eject plate with deionized water and/or ethanol. 
e. Check the “Empty and clean Tip Waste/Liquid Waste” box. 

 
7. Clean each channel:  stop disk, o-ring, and tip eject sleeve. 

a. Wipe the pipettor channels with a kimwipe dampened with deionized water. 
b. Check the “Clean each channel:  stop disk, o-ring, and tip eject sleeve” box. 

 
8. Clean the side covers 

a. Clean the Nimbus enclosure with deionized water and/or ethanol. 
b. Check the “Clean the side covers” box. 

 
9. Select the “Check tightness of Pipette Channels” box. 

a. Read the message that appears, remove the tip eject plate, close the door, and click “Continue”. 
b. The system will automatically test the o-ring seals of the channels. 

 
10. Select the “Check cLLD” box. 

a. Read the message that appears, ensure the tip eject plate is still removed and the door is still closed, and 
click “Continue”. 

b. The system will automatically test liquid level sensing. 
 
11. Click “OK” to acknowledge that the maintenance has completed successfully. 
 
12. Replace the tip eject plate. 
 
13. Click “Close”. 
 
14. Exit the Maintenance software. 
 
Semi-Annual Maintenance: 
 
At least once a year a service engineer from Hamilton will perform maintenance and calibration of the Nimbus. 
 
REFERENCES: 
 
Microlab® Nimbus Independent Channel Operator’s Manual.  Hamilton Robotics. 
Microlab® Nimbus Enclosed Version Operator’s Manual.  Hamilton Robotics. 
Microlab® Nimbus Independent Channel Programmer’s Manual.  Hamilton Robotics. 
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6.7 QIACUBE MAINTENANCE 
 

6.7.1 MONTHLY MAINTENANCE  
 

1. Clean the optical sensor, tip adapter, gripper unit, including the gripper, the stabilizing rod, and the spin 
column lid holder, by carefully wiping these modules with a soft lint-free cloth moistened with water. To 
gain access to the modules within the robotic arm:  

a. Press “Tools” in the main menu.  
b. Select “Maintenance” by pressing the up/down arrows to scroll through the list until it is 

highlighted, and then press “Select”. 
c. Select “Cleaning position” by pressing the up/down arrows to scroll through the list until it is 

highlighted, and then press “Start”. 
d. Follow the instructions displayed in the touchscreen. You will be instructed to remove the waste 

drawer and the labware tray.  
The robotic arm will move forward and downwards, enabling the modules to be accessed for cleaning 
through the opening for the waste drawer. 
 

2. After cleaning the modules of the robotic arm, switch off the QiaCube at the power switch. 
  

3. Thoroughly wipe the worktable with a soft lint-free cloth moistened with cleaning agent. Incubate as 
appropriate, rinse with distilled water, and wipe dry with paper towels. 

 
4. Clean the shaker rack, labware tray, heating adapter, and reagent bottle rack with cleaning agent. Incubate 

as appropriate, rinse thoroughly with distilled water, and wipe dry with paper towels. 
 

5. Clean the liner of the waste drawer with cleaning agent. Incubate as appropriate, rinse with distilled 
water, and wipe dry with paper towels. 

 
6. Thoroughly wipe the inside and outside of the QiaCube using the cleaning agents.  

 
Important: Do not use alcohol or alcohol-based disinfectants to decontaminate the QiaCube door.  
 
Important: Take care that no liquid runs down the touchscreen. Liquid may be drawn through the dust 
protection sealing by capillary forces and cause malfunction of the display. To clean the touchscreen, moisten a 
soft lint-free cloth with 70% ethanol or a mild disinfectant and carefully wipe the display. Wipe dry with a 
paper towel. 

  
6.7.2  SEMI-ANNUAL MAINTENANCE 
 
The centrifuge lid must be open to allow access to the inside of the centrifuge. The lid should be opened only 
after the centrifuge has come to a complete stop. If the lid does not open automatically, perform the following 
steps.  
1. Press “Tools” in the main menu. 
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2. Highlight “Maintenance” (scroll through the list by using the up/down arrows), and press “Select”. 
 

3. Highlight “Open lid” (scroll through the list by pressing “�” or “�”), and press “Select”.  
 
Cleaning the rotor and buckets 
  
1. Switch off the QIAcube at the power switch. 

  
2. Remove used disposable labware, sample tubes, and reagents from the worktable. Discard according to 

your local safety regulations. 
 

3. Close the buffer bottles tightly, and store according to the instructions in the relevant kit handbook. 
 

4. Remove all disposable rotor adapters, including tubes and spin columns, from the buckets. 
 

5. Remove the buckets from the rotor. Undo the rotor nut on top of the rotor using the rotor key, and 
carefully lift the rotor off the rotor shaft. 

 
6. Submerge the rotor, buckets, and rotor nut in cleaning agent. Incubate as appropriate. 

 
7. Rinse thoroughly with distilled water. Use a brush (i.e., a toothbrush or tube brush) to clean any parts 

that are difficult to access, such as the bucket mount and the rotor head. Wipe surfaces dry with a soft lint-
free cloth. If available, dry the buckets and rotor with pressurized air. 

 
Important: Make sure the paper towels and brush used are lint-free. 
 
Important: Make sure that all residual salt is removed. 
 
Important: Make sure to remove all traces of cleaning agent from the centrifuge buckets. Residual agent 
can cause the buckets to jam. 

 
8. Apply a few drops of mineral oil (Anti-Corrosion Oil (rotor), cat. no. 9018543) on a soft, lint-free cloth, 

and wipe the bucket mount and rotor claw. A thin, invisible oil film should cover the bucket mount and 
rotor claw, but no droplets or smear should be apparent. 
  

9. Apply oil to the rotor claw and to the bucket mount.  
 

Important: Before applying oil to the rotor buckets on the rotor, make sure that the rotor and all buckets are 
completely dry. 

 
Cleaning the centrifuge  
 
1. Moisten a soft lint-free cloth with cleaning agent, and clean the inside of the centrifuge and the centrifuge 

gasket. Incubate as appropriate. 
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2. Clean the inside of the centrifuge and the gasket with distilled water, and wipe dry with lint-free paper 
towels. If available, use a vacuum cleaner.  

 
Important: Make sure the gaskets remain in the proper positions. 

   
3. Clean the centrifuge lid with a soft lint-free cloth moistened with cleaning agent. Incubate as appropriate, 

clean with water, and wipe dry with paper towels. 
  

4. Check the centrifuge gasket for damage. If the gasket is damaged or shows signs of wear, contact QIAGEN 
Technical Services.  
 

Installing the centrifuge rotor and buckets 
 

1. Mount the rotor. The rotor can be mounted in only one orientation. The pin on the rotor shaft fits into a 
notch on the underside of the rotor directly underneath rotor position 1. Line up position 1 of the rotor 
with the pin on the rotor shaft and carefully lower the rotor onto the shaft. Install the rotor nut on top of 
the rotor and tighten using the rotor key supplied with the QIAcube. Make sure that the rotor is securely 
seated. 
  

2. Replace the rotor buckets. When replacing the rotor buckets, the side of the rotor bucket that must face 
toward the rotor shaft is marked with a gray line. Hold the bucket at an angle with the gray line facing the 
center of the rotor and hang the bucket on the rotor. Check that all buckets are properly suspended and 
can swing freely.  
 

Important: All centrifuge buckets must be mounted before starting a run. 
  

Tightness Test 

The tightness test is performed to check whether the tightness of the pipetting system, including the attached 
pipetting tip, is sufficient.  

1. Load an empty 2 ml safe- lock microcentrifuge tube in position 1 of the shaker. 
  

2. Fill a reagent bottle with 96% ethanol and place in position 1 of the reagent bottle rack. 
 

3. Load a tip rack of the filter tips you want to test (1000 μl or 1000 μl wide-bore) onto the QIAcube. 
 

4. Make sure that the QIAcube is switched on. 
 

5. In the main menu, press “Tools”. 
 

6. Select “Maintenance” by pressing the up/down buttons to scroll through the list until it is highlighted, and 
then press “Select”. 

 
7. Select “Tightness test” by pressing the up/down buttons to scroll through the list until it is highlighted, 

and then press “Select”. 
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8. Select the appropriate type of filter-tips (“1000 μl tips” or “1000 μl wide-bore tips”) by pressing the 

up/down buttons to scroll through the list until it is highlighted, and then press “Select”. 
 

9. Press “Start” to start the tightness test with the selected type of filter-tips. 
 

10. Follow the instructions displayed in the touchscreen, and press “Start” to start the tightness test. After the 
load check, the robotic arm will pick up a tip, aspirate ethanol, and move to the tube. The tip will remain 
in place above the tube for 2 minutes. The tip will be detached. 

 
11. After the protocol is completed, open the QIAcube door and check if the tube contains liquid. If the tube 

is still empty and dry, the tightness of the pipetting system is adequate. If you find liquid in the tube, 
contact QIAGEN Technical Services.  

  
6.7.3 ANNUAL MAINTENANCE 
 
A Qiagen Service Engineer will perform maintenance on an annual basis. 
 

 
6.8 QIASYMPHONY MAINTENANCE 

 
6.8.1 DAILY MAINTENANCE 

 
After every day in which the QiaSymphony is run: 
 
Tip Disposal Chute 
  
1. Remove, clean, and rinse the tip disposal chute. Ensure it is dry before reinstalling. 
 
Liquid Waste Container 
 
1. Remove and empty the liquid waste container into the waste barrel for EZ1 reagents. 

  
2. Clean and rinse the liquid waste container. 

 
3. Replace liquid waste container. Note: the liquid waste container can be autoclaved (121oC for 20min). 

 
Drawers and lysis station 

1. Remove all removable objects (tube/plate carriers, adapters, inserts, liquid waste station/tip park station, 
tip disposal chute, liquid waste bottle) from the drawers. 
 

2. Wipe the drawers and the removed objects as well as the lysis station with ethanol-based disinfectant and 
incubate as appropriate. Then wipe with a cloth moistened with water and dry with paper towels. Return 
the objects to the drawers. 
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3. Optional: Clean the removed objects by soaking them in a glyoxal and quaternary ammonium salt based 

disinfectant (e.g., Lysetol AF). 
 

Important: There are spikes below the piercing device in the “Reagents and Consumables” drawer that ensure 
that the reagent cartridge is correctly positioned. Take care when cleaning the “Reagents and Consumables” 
drawer. 

Magnetic Head 

1. Remove the cover from the magnetic head. 
2. Wipe the exterior of the magnetic head with a lint-free cloth moistened with ethanol-based disinfectant 

and incubate as appropriate. 
3. Wipe with a lint-free cloth moistened with water and dry with paper towels. 
 
Magnetic Head Guards 
 
1. Check the magnetic-head guards. If required, clean before starting the next protocol run. 
2. Open the “Maintenance” menu and run the service protocol “MH guard”. Gently raise the catches to 

release the magnetic-head guards. 
3. Wipe the magnetic-head guards with ethanol-based disinfectant and incubate as appropriate. 
4. Wipe with a lint-free cloth moistened with water and wipe dry with paper towels. Replace the magnetic-

head guards. 
5. Open the “Maintenance” menu and run the service protocol “MH guard open”. Make sure to replace the 

magnetic-head guards before operating the instrument. 
 
Conveyer Base Tray 
 
1. Carefully remove the conveyor base tray from below the magnetic head. 
2. Soak in a glyoxal and quaternary ammonium salt based disinfectant (e.g., Lysetol AF) for at least 15 min. 
3. Rinse with water and wipe dry with paper towels. Note: The tray can also be autoclaved at 121°C for 20 

min. 
 
Robotic Gripper 
 
1. Wipe the robotic gripper with a lint-free cloth moistened with ethanol-based disinfectant. Incubate as 

appropriate. Important: Only wipe the weight. Do not wipe the rods otherwise the ball mechanism may 
become jammed. 

2. Wipe with a lint-free cloth moistened with water and dry with paper towels. 
 
Pipetting System and Guards 
 
1. Remove all 4 tip guards by pushing each tip guard upward until it clicks out of place and can be removed. 
2. Soak in a glyoxal and quaternary ammonium salt based disinfectant (e.g., Lysetol AF) for at least 15 min. 
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3. Rinse with water and wipe dry with paper towels. Make sure to replace the tip guards before operating 
the instrument. 

  
6.8.2 WEEKLY MAINTENANCE 
 
Drawers and lysis station 
 
1. Remove tube/plate carriers, adapters, and inserts and soak them in disinfectant (e.g., Lysetol AF). 

Incubate for at least 15 min, then rinse with water and dry with paper towels. 
2. Check the condition of the bar code labels and make sure that they are not scratched. 
 
Touch Screen 
 
Wipe the touch screen with ethanol-based disinfectant and incubate as appropriate. Then wipe with a cloth 
moistened with water and dry with paper towels. 
 
QiaSymphony Hood 
 
Wipe the surface with a soft lint-free cloth moistened with deionized water. Then dry with a dry soft lintfree 
cloth or paper towel. Important: Do not use ethanol-based disinfectant. 
 
O-Rings 
 
The tightness of the tip adapter O-ring should be checked weekly and the O-ring must be changed monthly.  
 
1. In the “Tools” screen, press “Service SP” or “Service AS”. Then select the service script 

“CheckPipettingChannelORing.lua”. 
2. Press “Start” to start the tightness test. 
3. Follow the instructions in the messages displayed on the touchscreen. When instructed to do so by the 

software, place an empty tip-rack containing 4 test tips into the tip rack slot shown in the software 
message (see picture on next page). Note: Do not start an inventory scan during the protocol run. When 
the inventory scan message appears, press “No, nothing changed”. 

4. If after running the tightness test for a particular tip adapter a message is displayed with “Failed”, the O-
ring must be changed. If one tip adapter fails the tightness test, we recommend changing all 4 O-rings at 
the same time.  

 
6.8.3 MONTHLY MAINTENANCE 
 
O-Rings 
 
The O-rings must be changed every month using the “O-Ring Change Tool Set” (cat. no. 9019164). 
 
Using the “O-Ring Change Tool Set” to perform O-ring change  
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Before removing the old O-ring, the new O-ring must be prepared. These steps should be performed for both 
the QIAsymphony SP and the QIAsymphony AS instruments. For instructions, refer to the quick guide that is 
included with the “O-Ring Change Tool Set” (cat. no. 9019164).  

 
6.9 7500 SDS CALIBRATION / VERIFICATION PROCEDURES 

 
The information for the procedures detailed in this section was taken from the Applied Biosystems 
7300/7500/7500 fast real-Time PCR System Installation and Maintenance Guide.   When the yearly calibration 
checks are performed, the analyst performing the calibration must check the lamp usage and status. Procedure 
6.8.7.1 details checking the lamp usage and status.  The halogen lamp located in the 7500 SDS Instrument has a 
life span of approximately 1,000 hours.  If the lamp has exceeded 1,000 hours, or if a message is displayed that 
recommends changing the lamp, procedure 6.8.7.2 should be followed. 
 

6.9.1 BLOCK CONTAMINATION CHECK 
 

Purpose:  A check for contamination allows a user to determine if there are any areas of possible contamination 
in the wells of the plate holder that would artificially increase the fluorescence in those wells during a run, 
thereby increasing the quantitation result. 
 
Preparing the Check  This check is performed without a plate being positioned in the plate holder; therefore, if 
there is a plate in the holder, remove it, and then close the carriage door over the sample block and lock it 
down.   
 
Note:  This check is for information only and should not be saved using the 7500 System software during or 
after the check.  See step 3 below for instructions on documenting the contamination check. 
 
Performing the Check 

 
1. Turn on the instrument and open the SDS software. Click File>New. In the new document wizard click 

Finish to accept the default parameters.  
  

2. Click on the “Instrument” drop-down menu and select “Calibration”. Click “Yes” to lower the block. In 
the “Calibration” window select Filter A (FAM filter position), open the ROI Inspector and take an image 
at 2048ms by selecting Snapshot. 
 

3. Observe the background fluorescence in the 96 wells.  Note any wells that have significant fluorescence; 
fluorescence indicates contamination.  For documentation, perform a Screen Shot (Alt + PrintScrn) and 
then paste it (Ctrl-V) into a Microsoft Word blank document. 
 

4. To determine an acceptable background fluorescence level: 
a. Push the instrument carriage and allow it to spring back to open it. 
b. Put a new, clean, empty reaction plate without the cover into the sample block. 
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c. Push the carriage forward to close it. 
d. Take another image at 2048 ms.  For documentation, perform a Screen Shot (Alt +PrintScrn) and 

then paste it (Ctrl-V) into a Microsoft Word blank document. 
e. Save as Calibration Contamination check (MM/DD/YY) in the appropriate instrument folder. 

 
5. If some of the wells still appear to have significant fluorescence, clean them per the instructions in 

“Cleaning the Sample Wells”. 
 

Recheck the wells after cleaning, following steps 1 through 3 above. 
 

6.9.2 7500 REGIONS OF INTEREST CALIBRATION 
 

MATERIALS REQUIRED: 
 

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
 

2. ROI Calibration Plate (Part No. 4349415)   
 

3. Centrifuge and vortex 
 

Purpose: 
A Regions of Interest (ROI) calibration maps the positions of the wells on the sample block so that the 
software can associate increases in fluorescence during a run with specific wells of the plate.  A calibration 
image is needed for each well or filter to account for minor differences in the optical path. 

 
Preparing the Plate 
Retrieve the ROI calibration plate from the spectral calibration kit from the freezer in the amplified DNA 
room freezer.  Allow the plate to thaw.  Leave the optical film on the plate. (Do not discard the packaging as 
the plate can be used up to three times).  Vortex and centrifuge the thawed plate to assure that the liquid is in 
the bottom of the plate wells. 

 
Creating a Plate Document for the ROI Calibration 

 
1. Start the instrument and open the SDS software.  Load the ROI calibration plate into the plate holder 

position. 
 

2. Click File > New  
In the New Document wizard or dialog box click Finish to accept the default parameters.  (The SDS 
software automatically saves the ROI data to a set of calibration files on the computer hard drive).   Click 
OK if any ROI error is displayed. 
 

3. In the SDS software, select Instrument > Calibrate 
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4. In the ROI inspector dialog box that appears, right-click the black area of the window, then select 

Display Properties. 
 

5. In the Image Viewer Control Properties dialog Box: 
a. Select Show Saturation 
b. In the Sat Threshold field, enter 4000. 
c. Click OK 
 

6. In the ROI Inspector dialog box, set the lamp control: 
a. Click Block up 
b. Select Idle from the Lamp Control drop-down list  
 

Performing the ROI Calibration 
 

1. In the ROI Inspector dialog box: 
a. In the Exposure Time field, enter 2048 for the 7500 and  
b. Select Filter A. 
 

2. Click Snapshot to generate an ROI image. 
 

3. Determine if your ROI image is acceptable.  An acceptable image will not have saturated red areas in any 
wells.  (A few red pixels in a well are acceptable).   
 
If the ROI image appears over saturated, continue to reduce the number in the Exposure Time Field 
(2048) by half until an acceptable image is obtained.  Once the acceptable image is produced, print this 
screen by pressing Alt + PrintScrn and then Ctrl V into a Microsoft Word blank document. 
 

4. If your image is acceptable, Click Generate Calibration. 
The software takes a snapshot, and then displays a message dialog box or an ROI image.  A successful 
calibration will have green circles around all wells. 
  
If the calibration image is not successful, see pg 45 for of the 7500 Installation and Maintenance Guide for trouble 
shooting. 
 

5. Click Save Calibration to save the image for filter A.  (An OK will appear in the dialog box for Filter 
A).  Remember to Save after every filter. 
 

6. Repeats steps 1 through 6 for the remaining filters:  Filters B, C, D and E.  Reset the Exposure Time to 
2048 before performing the calibration for each filter. 
 

7. Click Done > File > Close and click NO to save the plate document. 
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Unloading the Plate  
 

In the ROI Inspector dialog box, click Block Down and remove the plate.  Return the plate to the packaging if 
not performing background and optical calibration. 

 
6.9.3 Performing the Background Calibration on the 7500 SDS Instrument 
 
MATERIALS REQUIRED: 
 
1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
 
2. Background Plate (Part No. 4330124) 
 
3. Centrifuge and vortex 

 
Purpose  A background calibration measures the level of background fluorescence in the instrument.  The run 
will perform continuous reads of a background plate containing PCR buffer for 10 minutes at 60°C and 
average the spectral results to a calibration file.  The software can then use the file to remove the background 
fluorescence from the run data. 
 
Perform a background calibration after replacing the lamp or monthly, depending on instrument usage. 

 
Precautions Since the signal consists of fluorescence from several sources it is important to use gloves when 
handling the plate, use a clean centrifuge and vortex, and do not place the plates on the lab bench. 

 
Preparing the Background Calibration Plate  Retrieve the prepared background plate from the spectral 
calibration kit from the freezer in the amplified DNA room.  Allow the plate to thaw (Do not discard the 
packaging as the plate can be used up to three times).  Vortex and centrifuge the thawed plate to ensure that 
the liquid is in the bottom of the plate wells. 

 
Creating a Plate Document for the Background Calibration 
 
1. Place the prepared plate into the plate holder and close the tray/door.  Start the instrument and open the 

SDS software.  Click File > New. 
 
2. Configure the New Document Dialog box: 

a. Select Assay >Background.   
b. Select Container > 96-Well Clear.  
c. Select Template > Blank Document 
d. In the Operator field, enter a name. 
e. In the plate Name field, enter : Background_<date MMDDYY> and click Finish. 
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3. In the SDS software select File > Save As.  On 7500 #1, navigate to C:\SDS1.2\Documents and save.  
On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save.  Select Save as type > SDS 
Documents (*.sds). 

 
Performing the Background Calibration  In the SDS software: Select the Instrument tab and click Start.  The 
instrument begins the calibration run after the heated cover comes to temperature.   After the run is complete, 
click OK.  The background run may take 10 minutes.   

 
Analyzing the Background Calibration Data 
 
1. Click the green arrow or select Analysis > Extract Background.  The software extracts the 

background signal then displays Background Extraction Complete.  Click OK.   
 

If the message indicates the image exposure is too low, see pg 56 of the 7500 Installation and Maintenance Guide for 
trouble shooting. 

 
2. In the plate document, select the Results tab, then Spectra tab.  Print this page for the Background 

Calibration records and to show that the instrument is free of significant contaminants.  
 
3. Inspect the raw data for irregular spectral peaks that exceed the following fluorescent standard units 

(FSU).  All wells should be selected.  
 

Filter FSU 

A,B,C,D 
(7000/7500) 

>72,000 

E (7500) >90,000 

 
If the fluorescence exceeds the FSU indicated, see pg 64 of the 7500 Installation and Maintenance Guide for trouble 
shooting. 
 
If a contaminant is observed (high fluorescent data), see pg 108 of the 7500 Installation and Maintenance Guide for 
cleaning contaminants. 

 
4. Inspect the background plate image for bright areas of fluorescence and perform a Screen Shot (Alt + 

PrintScrn) and then paste it (Ctrl-V) into a Microsoft Word blank document for documentation. 
  

5. Select File > Close 
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6.9.4 PERFORMING THE OPTICAL CALIBRATION FOR THE 7500 SDS INSTRUMENT 
 

MATERIALS REQUIRED: 
 

1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
 
2. ROI Calibration Plate (Part No. 4349415) 
 
3. Centrifuge and vortex 

 
Purpose:  The optical calibration compensates for the physical effects of the additional filter present in the 
7500 instrument and needs to be performed after every 7500 system background calibration. 

 
Preparing the Optical Calibration Plate 
Retrieve the prepared ROI plate from the spectral calibration kit from the freezer in the amplified DNA room.  
Allow the plate to thaw (Do not discard the packaging as the plate can be used up to three times).  Vortex and 
centrifuge the thawed plate to ensure that the liquid is in the bottom of the plate wells. 

 
Creating a Plate Document for the Optical Calibration 
 
1. Start the instrument and open the SDS software.  Load the ROI calibration plate into the plate holder 

position. 
  
2. Click File>New. 
 
3. Configure the New Document Dialog box: 

a. Select Assay >Calibration.   
b. Select Container > 96-Well Clear.  
c. Select Template > Blank Document 
d. In the Operator field, enter a name. 
e. In the plate Name field, enter : 
 Calibration_<date MMDDYY> and click Finish. 

4. In the SDS software select File > Save As.  On 7500 #1, navigate to C:\SDS1.2\Documents and save.  
On 7500 #2, navigate to D\: > SDS 1.2 >SDS Documents and save. 

 
Performing the Optical Calibration 
In the SDS software: Select the Instrument tab and click Start.  The instrument begins the calibration 
run (10 min.) after the heated cover comes to temperature.  After the run is complete, click OK. 
 
Analyzing the Optical Calibration Data 
Click the green arrow or select Analysis > Extract.  The software extracts the optical calibration then 
displays a message indicating the extraction is complete.  Click OK. 
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Click on the Results and Spectral Tabs.  Select all wells and print this screen.  Inspect the raw background 
data for any irregular spectral peaks. 
 
For any error messages, see pg 64 of the 7500 Installation and Maintenance Guide for trouble shooting 

 
Click File>Close. 

6.9.5 PERFORMING THE PURE DYE CALIBRATION ON THE 7500 SDS INSTRUMENT 
 

MATERIALS REQUIRED: 
 
1. Applied Biosystems 7500 Real-Time PCR Systems Spectral Calibration Kit I  
(PN 4349180 containing Pure Dye Plates FAM, JOE, NED, ROX, SYBR Green, TAMRA, and VIC). 
 
2. Centrifuge and vortex 

 
Purpose  During a pure dye calibration run, the system collects spectral data from a series of pure dye 
standards and stores the spectral information for the pure dye standards in the pure spectra run file, a 
calibration file in the SDS directory. 
 
The software then uses the pure spectra data during subsequent runs to characterize pure dyes and distinguish 
the individual contribution of each dye in the collective fluorescence collected by the instrument during a run. 
 
Important!  Before performing a pure dye calibration, you must perform an ROI calibration, a background 
calibration, and an optical calibration. 
 
Preparing the Plate Retrieve the pure dye plates from the spectral calibration kits from the freezer in the 
amplified DNA room.  Allow the plates to thaw (~5 minutes).  NOTE:  Do not remove a pure dye plate 
from its packaging until it is ready to be used.  The fluorescent dye in the wells of each pure 
dye plate is photosensitive.  (Do not discard the packaging as the plates can be used multiple times).  
Leave the optical film on the plates.  Although multiple pure dye plates are in Spectral Calibration Kit I, only 
the plates that are currently used for the quantitation chemistry being employed need to be run.  For 
Quantifiler and Quantifiler Duo, only FAM, VIC, ROX, and NED need to be run. 
 
Creating a Plate Document for the Pure Dye Calibration 
 
1. Start the instrument and open the SDS software.  Click File > New. 
 
2. In the New Document Wizard dialog box: 
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a. Select Assay > Pure Spectra. 
b. Select Container > 96-Well Clear. 
c. Select Template > Blank Document. 
d. In the Operator field, enter your initials. 
e. In the Comments field, enter the plate bar code number. 
f. Click Finish.  Note:  It is not necessary to name or save the pure dye plate document.  The SDS 

software automatically saves the pure dye data to a calibration file on the computer hard drive. 
 
Selecting the Dye 
 
In the Pure Spectra Calibration Manager dialog box: 
 

a. In the Dye List field, select a pure dye to calibrate. 
b. Click Calibrate. 
c. If you are prompted to disconnect the plate document, click Yes. 
d. A message prompts you to load the plate.  Do not click Yes or No at this point. 

 
Preparing and Loading a Pure Dye Plate 
 
1. Remove the appropriate Pure Dye plate from its packaging.  Do not discard the packaging as the plate can 

be used multiple times.  Leave the optical film on the plate. 
2. Vortex and centrifuge the thawed plate to assure that the liquid is in the bottom of the plate wells. 
3. Verify that the pure dye plate that you are about to load matches the dye selected in the Pure Spectra 

Calibration Manager. 
4. Load the plate in the instrument with the notch in the upper right corner. 
 
Performing the Pure Dye Calibration 
 
1. In the dialog box that prompts you to load the plate click Yes.  The run takes ~5 minutes to complete. 
2. When the SDS software completes the run, remove the pure dye plate from the SDS Instrument, place it 

back into its packaging, and place it back into its respective spectral calibration kit in the freezer. 
 
Calibrating remaining dyes: 
 
1. Click Next Dye >. 
2. Repeat the procedures in Preparing and Loading a Pure Dye Plate and Performing the Pure Dye 

Calibration to run the remaining pure dye plates. 
 
3. After you calibrate the instrument with all pure dyes provided in the spectral calibration kits, click 

Finish. 
 
Analyzing the Pure Dye Calibration Data 
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When each pure dye plate is run, the SDS Software automatically creates and saves a plate document for each 
dye.  After you calibrate all of the pure dye plates, the plate documents remain open behind the plate 
document displayed by the software.  To complete the calibration, analyze all open pure dye documents: 
 
1. From the Windows menu, select the plate document to analyze. 
2. Select the Results tab, then select the Spectra tab. 
3. Select all wells of the plate document by clicking the upper-left corner of the plate grid. 
4. Click the green arrow (or select Analysis > Extract Pure Spectra).  The SDS Software completes the 

extraction, then displays a message: 
 

If the software displays: Do this: 
Pure Spectra Extraction Complete – The analysis 
is successful. 

Click OK, then go to step 5. 
Important!  The pure dye 
calibration is not complete at this 
point.  Before closing the plate document 
you must inspect the Spectra plot as 
explained in steps 5 through 8 below. 

Repair Message—“The following wells require 
repair. . .” 

Click OK, then go to step 5. 
(For information on how the software 
auto-repairs calibration spectra, see 
“About Pure Dye Spectra” on pg 79 of the 
Applied Biosystems 7300/7500/7500 Fast 
Real-Time PCR System Installation and 
Maintenance Guide. 

Error Message—“Pure Spectra Extraction 
Detected an Unknown Error. . .” 

Click OK, load the plate, then run the 
pure dye plate again. 
If the calibration continues to fail, perform 
the calibration with a new pure dye plate. 

 
5. In the pure dye plate document: 
 

a. Select the Results tab. 
b. Select the Spectra tab. 

 
6. Select all wells of the plate document by clicking the upper-left corner of the plate grid. 
 
7. Using the tables below as a reference, verify that the peak for the spectrum of the pure dye occurs at the 

correct filter.  For documentation, Print the spectra for each dye (Alt + Print Scrn; then open a new 
blank Microsoft Word document and Ctrl V to paste the spectra).  If the peak for the spectra of a dye 
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occurs in the wrong filter, you may have run the wrong dye plate during the calibration.  Repeat the 
procedure using the correct dye.   

 

 
 
8. Select File > Close.  Important!  Do not close a plate document until you have extracted it.  During 

the calibration, the software creates plate documents for each pure dye plate as it was run.  You must 
extract each one individually before closing it. 
  

9. Repeat steps 1 through 8 to extract the calibration data for the remaining pure dyes. 
 

6.9.6 Running the TaqMan RNase P Plate Data on the ABI 7500 SDS 
 
MATERIALS REQUIRED: 
 
1. Applied Biosystems Real-Time PCR System Spectral Calibration Kit 
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2. TaqMan RNase P Instrument Verification Plate (Part No. 4350584) 
 
3. Centrifuge and vortex 
 
Purpose  The TaqMan RNase P Instrument Verification Plate run verifies the performance of an Applied 
Biosystems 7500 SDS instrument.  The RNase P plate is pre-loaded with the reagents necessary for the 
detection and quantification of genomic copies of the human RNase P gene. 
 
The RNase P plate contains five replicate groups of standards, two unknown populations and four no template 
control wells.  After the run, the SDS software will assess the instrument performance.   
 
Preparing the TaqMan RNase P Plate  Retrieve a prepared TaqMan RNase P Verification Plate kit from the 
freezer in the amplified DNA room and allow the plate to thaw (approximately 5 minutes).  Vortex and 
centrifuge the thawed plate to ensure that the liquid is in the bottom of the plate wells.  If the RNase P plate 
has a compression pad on it, remove it from the plate. 
 
Creating a Plate Document for the RNase P Verification Run 
 
1. Start the instrument and put the RNase P plate in the instrument. 
  
2. Open the SDS software and click File > New. 
 
3. In the New Document Dialog box: 

a. Select Assay >Absolute Quantification (standard curve).   
b. Select Container > 96-Well Clear.  
c. Select Template > AQ RNase P Install 
d. In the Operator field, enter a name for the RNase P plate (i.e. RNase P MMDDYY) click Finish 
e.    In the SDS software, select File> Save As.  (Navigate to D\:>AppliedBiosystems>SDS Documents 

and Save) 
 
Performing the Verification Run  In the SDS software: Select the Instrument tab and click Start.  (The 
instrument default parameters should be correct. The RNase P plate volume is 50ul). The instrument begins 
the run which lasts approximately 1.5 hours.  After the run is complete, click OK. 
 
Analyzing the TaqMan RNase P Plate Data 
 
1. Select Analysis > Analysis Settings. Select Auto Ct >Click OK.  Click the green arrow or select 

Analyze. 
 
2. Assess the results.  In the plate document: Select the Results tab then select the Amplification Plot 

tab. 
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4. Display the data: from the Amplification Plot tab: 
 

a. Click the upper-left corner of the plate grid to select all wells. 
 
b. Select Data > Ct vs. Well Position to display the plots.  Save this data. 

 
5. Verify the uniformity of each replicate population by comparing the groupings of Ct values. 
 

If outliers are present, omit and reanalyze (see page 93 of the 7500 Installation and Maintenance Guide for 
trouble shooting, this will apply to the 7000, as well). 

 
6. In the results tab, select the Standard Curve tab and verify that the R2 value is > 0.990. Save and print 

this data. 
 
7. In the Report tab, calculate the verification value of the 5,000-copy and 10,000-copy populations: 
 

a. For the 5,000-copy populations, in the Report tab, scroll to a sample in the 5K population.  Apply the 
value in the Mean Qty and StdDev Qty columns to the following equation:  

 
5K value = Mean Qty + 3(StdDev Qty) 

 
b. For the 10,000-copy populations, in the Report tab, scroll to a sample in the 10K population.  Apply 

the value in the Mean Qty and StdDev Qty columns to the following equation: 
 

10K value = Mean Qty – 3(StdDev Qty) 
 

8. Compare the values of the 10K and 5K-copy populations.  If the 10K value is greater than the 5K value 
the 7500 has passed. 

 
9. With all wells chosen, print the Report.  Save the Tabular Report Data and the Standard.  You may 

discard the Raw Data and the Delta Rn vs Cycle Data pages.  It is recommended that the calculations 
performed above be written on one of the Tabular Report Data pages. 

 
10. Close Program.  If asked to Save, click “yes”. 

 
Remove the plate and discard.  (note: the plate cannot be re-used) 

 
6.9.7 Monitoring and Replacing the Lamp on the 7500 SDS Instrument 

 
6.9.7.1 Monitoring the Lamp Status 
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The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 hours.  If the 
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the lamp, 
procedure 6.8.7.2 should be followed. 
 
1. Select File > New. 
 
2. In the New Document Wizard, click Finish. 
 

In the SDS Software, select Instrument>Lamp Status/Replacement.  In the Lamp 
Status/Replacement dialog box, the usage hours and lamp current are displayed.  The Condition field 
will indicate one of the following: 

 
Good—the lamp is functioning well. There is no need to replace the lamp bulb at this time.  Click 
Close. 
Failed—The lamp bulb must be replaced.  Click Close, then replace the lamp. 
Change Soon—the lamp bulb usage is above 2000 hours. It is recommended to replace the lamp 
soon.  Click Close, then replace the lamp. 

 
Warning messages may be displayed before or during a run that indicate low lamp current.  See page 121 of the 
Installation and Maintenance Guide for these messages, what they are describing, and how to proceed. 

 
6.9.7.2 Replacing the Halogen Lamp on the 7500 SDS Instrument 
 
The halogen lamp located in the 7500 SDS Instrument has a life span of approximately 1,000 hours.  If the 
lamp has exceeded 1,000 hours, or if a message is displayed that recommends changing the lamp, this 
procedure should be followed. 

 
MATERIALS REQUIRED: 
 
1. Halogen bulb (12V, 75W) 
 
2. Small pointed object, for example a screwdriver. 
 
Important:  Wear powder-free gloves when you handle the lamp. 
 
1. Power off, then unplug the 7500 SDS Instrument.  Allow the instrument to cool for 15 minutes. 
 
2. Open the access door to the Instrument: 
Insert a thin screwdriver or other object into the keyhole on the edge of the front access door, then push 

to unlatch the door.  Open the door. 
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3. Remove the lamp from the instrument: 
Slide the lamp release lever downward.  Firmly grasp the lamp and lift it up and out of the slotted mount. 
 
4. Inspect the lamp for signs of failure (see the Installation and Maintenance Guide page 124 for 

indications of lamp failure). 
 
5. Place the new lamp into the instrument 
Slide the lamp release lever upward.  Firmly grasp the lamp, place it into the slotted mount, then carefully 

slide the lamp downward into place. 
  
6. Close the access door. 
 
7. Plug in and power on the 7500 SDS Instrument. 
 
8. Open the 7500 System software program. 

 If the Quick Startup document dialog box is not open, select File > New.  In the New Document 
wizard, click Finish.  In the SDS software, select Instrument > Lamp Status/Replacement and 
click on Reset lamp timer then close. 

 
9. In the ROI Inspector dialog box, select Lamp Control > Idle. 
 
10. While the instrument is running, look through the grating of the access door and verify that the lamp 

is illuminated, then click Done. 
 
Important!  After replacing the lamp, the following calibrations must be performed:  ROI Calibration, 

Background and Optical Calibrations, Pure Dye Calibration, Instrument Performance Verification 
(RNase P Plate). 
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6.10 PROCEDURE FOR THE CALIBRATION CHECKS OF THE THERMOCYCLERS 
 
The thermocyclers used for the polymerase chain reaction amplification of DNA are located in the 
Amplification Room of the Forensic Biology Unit.  A calibration verification test and temperature non-
uniformity test are conducted on each thermocycler approximately every six months. The verifications are 
conducted by an outside vendor. 
  

6.11 3500 Maintenance 
 

OVERVIEW OF 3500 MAINTENANCE SCHEDULE: 
 
Weekly/Biweekly (recommended in the following order): 
Run the Wash Pump and Channels Wizard (weekly) 
Clean anode buffer cup pin-valve assembly (weekly) 
Place new Anode Buffer Container on instrument (Hard Stop) (bi-weekly) 
Replace Cathode Buffer Container (Hard Stop) (bi-weekly) 
Restart computer and instrument (weekly) 
 
Monthly: 
Flush the Pump Trap 
Replace septa on Cathode Buffer Container 
Clean the autosampler and drip tray 
Defragment Hard drives 
 
As needed: 
Replace Polymer 
Spatial Calibration 
Spectral Calibration 
Replace Capillary Array (also requires spatial and spectral) 
Pump cleaning 
 
Powering on the 3500 and launching the Data Collection software 
 
1. Power on the computer. At the Log On prompt, log in to the computer. 
 
2. Before turning on the 3500 instrument, ensure that the oven door is closed and locked, that the 

instrument doors are closed, and the computer is powered on. 
 
3. Power on the instrument by pressing the on/off button on the front of the instrument. Ensure that the 

green status light is on and not flashing before proceeding. 
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4. Click on the 3500 Series Data Collection Software 2 icon on the desktop. Log in to the data 
collection software with the password taped to the monitor.  

 
5. Use the Dashboard to review maintenance notifications. When you complete a task, click the green 

check mark to indicate that it was completed, or the red X to mark it as dismissed. 
 
6. Click on Maintenance on the top panel. Use the left panel to navigate to the schedule calendar or 

Maintenance Wizards to complete the needed maintenance. 
 
Weekly Maintenance 
 
At least 30 minutes prior to beginning weekly maintenance, bring Conditioning Reagent, POP-4 
Polymer*, Anode buffer container, and Cathode Buffer Container to equilibrate to room temperature.  
*If polymer remains before the expiration date, and there are still injections left in the pouch, polymer can 
be reused for a total of approximately four weeks on the instrument before it needs to be replaced.  
 
Run the Wash Pump and Channels Wizard 
 
This wizard takes about 40 minutes from start to finish. Click ‘Maintenance’ on the top panel, and 
‘Maintenance Wizards’ on the left to find the ‘Wash Pump and Channels’ wizard.  
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Follow the wizard prompts to empty the anode buffer (NOTE: The EMPTY anode buffer container is placed 
back on the instrument for the water wash), remove polymer, insert conditioning reagent, and insert 
polymer to flush the pump chamber and channels.  
 
Clean anode buffer container valve pin assembly 
 
Following pump chamber and channels wash, and before installing the new anode buffer container, use a 
clean lint-free cloth and deionized water to wipe clean the anode buffer container valve pin assembly on the 
polymer delivery pump.  
 
Place new Anode Buffer Container on instrument 
 
1. Remove Anode Buffer Container from outer plastic wrap. Ideally, this is done after the wash pump and 

channels wizard. 
 
2. Tilt it slightly to make sure that most of the buffer is in the larger side of the container. There should be 

less than 1 mL of buffer remaining in the small side of the container. Verify that buffer is to the fill line.  
 
3. Gently peel off the plastic seal on the top without spilling any into the small side of the container. If it 

does spill into the overfill side, pipette it back into the reservoir so that the liquid reaches the fill line.  
 
4. Place the Anode Buffer Container (label side first) under the valve pin assembly, and slowly slide the lip 

of the container into the locks.  
 
Replace Cathode Buffer Container (replacing septa only once per month) 
 
1. Remove Cathode Buffer Container from outer plastic wrap and peel off plastic seal from the top, 

ensuring that it is peeled off of every circular opening.  
 
2. Wipe off any buffer on top of the container with a lint-free cloth. Ensure that the top of it is dry.  
 
3. Press tray on the front of the instrument to bring the autosampler forward. Remove the old cathode 

buffer by pinching in the middle. 
 
4. Place the appropriate cathode buffer septa on both sides of the cathode buffer container. These only 

need to be replaced once per month. Septa can be washed with water and returned to the new cathode 
buffer. 

 
5. Install the new buffer by clicking it into the tabs on the autosampler.  
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6. Close the instrument door to re-initialize.  
 
Restart computer and instrument 
 
1. Close data collection software.  
 
2. Shut down computer. 
 
3. Once computer is shut down, press the power button on the instrument.  
 
4. Restart computer, but don’t log in.  
 
5. Once the computer is on, turn the 3500 back on by pressing the power again. Let the instrument 

initialize and wait for the solid green light to appear before logging on to the computer. 
 
6. Click on the 3500 Series Data Collection Software 2 icon on the desktop. Log in to the data 

collection software (it may take a minute for the connections to be reestablished before the software can 
open).  

 
Monthly Maintenance 
 
Flush the Pump Trap  
 
The water trap must be flushed once per month (or more often as needed) to prolong the life of the pump 
by cleaning any diluted polymer and clearing air bubbles. 
 
1. Fill the supplied 20 mL, all-plastic Luer lock syringe with nanopure water. Do not use a syringe smaller 

than 20 mL. Doing so may generate excessive pressure within the trap. Expel any bubbles from the 
syringe. 

 
2. Attach the syringe to the forward-facing Luer fitting at the top of the pump block. Hold the fitting with 

one hand while threading the syringe onto the fitting with the other hand. 
 
3. Open the Luer fitting by grasping the body of the fitting and turning it to loosen. Attached syringe and 

turn counterclockwise approximately one half turn. 
 

IMPORTANT! Do not use excessive force when you push the syringe plunger as this may damage the trap 
seals. Take approximately 30 seconds to flush 5 mL of nanopure water through the trap. 
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4. Remove the syringe from the Luer fitting. Hold the fitting with one hand while turning the syringe 
counterclockwise with the other hand. 

 
5. Close the Luer fitting by lightly turning clockwise until the fitting seals against the block. 
 
6. Dispose the excess water inside the overflow container. 
 
Replace septa on Cathode Buffer Container 
 
Once per month, change both of the septa on the Cathode Buffer Container during the weekly 
maintenance.  
 
Clean the autosampler and drip tray 
 
Wipe them down with a lint-free cloth and either deionized water or absolute ethanol 
 
Defragment hard drives 
 
Click the Windows Start icon to find Disk Defragmenter and open it. Click on each disk and click 
‘Analyze’ to determine the degree of fragmentation. Click ‘Defragment’ for every disk that is 
fragmented. This may take several minutes to hours depending on the degree of fragmentation. 
 
As Needed Maintenance 
 
Replace Polymer 
 
If there isn’t sufficient polymer to complete your run or if the polymer has exceeded 4 weeks use on the 
instrument, it is necessary to place a new polymer pouch on the instrument. Get a new polymer pouch and 
let it equilibrate to room temperature before replacing the old one. Use the Replenish Polymer wizard 
to complete this. Follow the wizard prompts in order to flush the pump of the old polymer and refill the 
capillaries with the new polymer. This wizard takes 10-20 minutes to complete 
 
Spatial Calibration 
 
The 3500 Series Data Collection software uses images collected during the spatial calibration to establish a 
relationship between the signal emitted by each capillary and the position where that signal is detected by 
the CCD camera. A spatial calibration is required to ensure correct alignment of the capillaries and optimal 
detection of the signal in each capillary. 
 
A new spatial calibration is recommended when: 
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 A capillary array is installed, replaced or temporarily removed from the detection block 

 The instrument is moved 

 The detection cell door is opened 
 
Perform Spatial Calibration and Evaluate Results 
 
1. Click ‘Maintenance’ on the Dashboard. Click ‘Spatial’ under the Calibrate heading on the left. 

 
2. Select No Fill, or select Fill to fill the array with polymer before starting the calibration. 

 
3. Click ‘Start Calibration’. The display updates as the run progresses. 

 
4. When the run is complete, evaluate the spatial calibration profile to ensure that you see the following: 

 One sharp peak for each capillary. Small shoulders may be acceptable. 

 One marker (+) at the apex of every peak. No off-apex markers. 

 An even peak profile (all peaks about the same height). 

 The Max Spacing – Min Spacing should be no more than 2 pixels. 
 
5. If the results meet the criteria above, click ‘Accept Results’.  
 
Note: If any peaks are lower than usual for the instrument or the heights drastically slope up or down, 
repeat the calibration with a fill. See below for an example of an acceptable Spatial Profile. 

 
 
6. Click ‘View Spatial Calibration Report’. 
 
Spectral Calibration 
 
A spectral calibration creates a matrix that corrects for the overlapping fluorescence emission spectra of the 
dyes. Although each of these dyes emits its maximum fluorescence at a different wavelength, there is some 
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overlap in the emission spectra between the dyes. The goal of multicomponent analysis is to effectively 
correct for spectral overlap and minimize the presence of artifacts, such as spectral pull-up, in the data. 
 
A new spectral calibration is recommended/required when: 

 The capillary array is changed (required) or temporarily removed from the detection block. 

 The instrument is moved. 

 The laser or CCD camera has been realigned/replaced by a service engineer. 

 An increase in (pull-up and/or pull-down peaks) is observed. 

 A new dye set is used on the instrument. 

 The capillary array length or polymer type is changed. 

 The detection cell door is opened (not required by the software, but recommended). 
 
Perform Spectral Calibration and Evaluate Results 
 
1. Pre-heat the oven by clicking ‘Start Pre-heat’. 
 
Note: Preheating for approximately 30 minutes helps mitigate subtle first-run migration rate effects. The 
pre-heat function automatically turns off after 2 hours. 
 
2. Click ‘Maintenance’ on the Dashboard. Click ‘Spectral’ under the Calibrate heading on the left 

panel. 
 

3. Check the pump assembly for bubbles and run the Remove Bubble wizard if needed. 
 

4. Vortex the appropriate Matrix Standard. Prepare the Master Mix: 
 
For GlobalFiler® and YfilerTM Plus analysis, use Dye Set J6.  

a. Standard: 10 μL 
b. HIDI Formamide: 290 μL 

 
Note: Volumes other than above may be used to obtain spectral peaks between 3000-10000 rfu.  The total 
volume should not exceed 300uL.  
 
Note: After a capillary array is changed, a new spectral calibration must be run for each dye set.  
 
5. Load 10 μL of matrix standard/HIDI mixture into wells A1-H1 of a 96-well reaction plate. Note: 

multiple matrix samples (i.e., J6 or G5) can be run in subsequent columns on this plate if needed) 
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6. Cover the plate with a 3500 septa mat and centrifuge to ensure that the samples are at the bottom of the 
wells and place the reaction plate in the Veriti® thermal cycler. 

 
7. Denature the samples by running the spectraldenature protocol on the 9700 (95°C, 5 min).  
 
Note: The cover plate of the Veriti® thermal cycler may be closed onto the septa mat-covered reaction 
plate, but do not clamp the cover down.  Although the lid is not heated during the denature protocol, it 
may stick to the septa mat and pull it up when the cover is opened if it is clamped down. 
 
8. After the denaturation protocol is finished, chill the reaction plate immediately in the 96-well cooling 

block (-20°C) for at least 3 minutes. 
 

9. Place the plate into a 3500 Series 96-well plate base (it will only fit in one orientation) and cover with a 
3500 Genetic Analyzer 96-well plate retainer.  Check to ensure that the retainer clip is properly seated. 

10. Press the tray button on the front of the 3500 Genetic Analyzer. When the autosampler tray presents 
itself, open the door of the instrument and place the tray onto the either position of the autosampler 
(the tray will only fit in one orientation). Tilt the plate toward the middle, first before lowering into the 
side clip. Close the instrument door. 

 
11. In the 3500 Series Data Collection Software 2, Click ‘Maintenance’ on the dashboard. Click 

‘Spectral’ under the Calibrate heading on the left. 
 

12. Select the number of wells (96), plate position, chemistry standard (Matrix Standard) and dye set (J6 or 
G5). Select allow borrowing. 

 
13. Click ‘Start Run’. Run takes ~30 minutes to complete. Passing capillaries are shown in green and 

failing capillaries are shown in red. Borrowed capillaries are shown in yellow with an arrow indicating 
the adjacent capillary from which results were borrowed.  

 
14. Evaluate each capillary for the following: 

 Order of the peaks in the spectral profile from left to right: 
J6: blue, green, yellow, red, purple, orange (an example is below) 

 Peak heights are sufficiently robust (>2,000 RFU) and do not contain extraneous peaks, gross 
overlaps, dips, or irregular morphology. If peak heights exceed 10,000 RFU, set up another plate 
with a reduced amount of matrix standard. If peak heights are below 2,000 RFU, set up another 
plate with an increased amount of matrix standard. See below for an example of an acceptable J6 
spectral profile.G5 is similar, but without the purple.  
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15. If the results meet the criteria above, click ‘Accept Results’. If the results do not meet the criteria, set 

up another plate, adjusting amount of matrix standard, if necessary, and run again.  
 
Installing or replacing the capillary array 
 
It is recommended that the capillary array be replaced after 160 injections per capillary, or removed from 
the instrument for storage if the instrument is to be shut down for an extended period of time; however, 
capillary life may be extended based on the quality of the data obtained from the array. 
 
Select the ‘Install Array Wizard’ for guidance. This wizard takes 15-45 minutes to complete. 
 
Note: A spatial calibration AND spectral calibration are required after a capillary array change. The 
instrument will not run without a new spectral calibration associated with that capillary RFID tag. 
 
Removing bubbles from the pump block 
 
Periodically, check the pump chamber, channels and tubing for air bubbles.  Press the button on the right 
hand side of the front of the instrument to turn on the lamp inside the instrument. This will help locate any 
air bubbles. 
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Select the ‘Bubble Removal Wizard’ for guidance. This wizard takes 5-15 minutes to complete. 
 
Pump Cleaning 
 
In nearly all circumstances, the Water Wash Wizard is very effective in cleaning the pump assembly. 
Occasionally, a situation in which the Water Wash Wizard is not sufficiently effective may arise. If polymer 
has dried in the channels of the lower block, or if some contamination in the pump assembly is suspected, 
use the Pump Cleaning Kit to thoroughly clean the pump assembly.  
 
If this procedure is needed, refer to the Pump Cleaning Kit Protocol for 3500 Series Analyzers. 
 
REFERENCES: 
Applied Biosystems 3500/3500xL Genetic Analyzer User Guide 
Applied Biosystems 3500/3500xL Genetic Analyzer User Bulletin 
Product insert sheet from Dye Set J6 (Pub. Number 4426042 Rev. A) 
Pump Cleaning Kit Protocol for 3500 Series Analyzers 
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7.0  COLLECTION KITS AND SUPPLY ORDERING 
 

7.1 PREPARATION OF EVIDENCE COLLECTION KITS 
 

The Forensic Biology Unit provides officers, investigators, and sexual assault nurses with six types of kits used in 
the collection of biological evidence.   
 
In general, the Laboratory Technician is responsible for preparing and disseminating the kits, however, the unit 
as a whole is responsible for these kits.  A point person may be assigned the responsibility of these kits.  A 
minimum stock should be kept on hand at all times in order to fill requests promptly.  Kit components should 
also be prepared and kept on hand.  Kits and kit components should be made on a sterile surface.  Use protective 
gloves and a laboratory coat when preparing and handling kits and kit components. 

 
7.1.1 REFERENCE MOUTH SWAB COLLECTION KITS 

 
Keep 60-100 kits on hand at all times. 
 
Place the following items in a Reference Mouth Swab Collection Kit envelope (a manila envelope with ‘SDPD 
REFERENCE MOUTH SWAB COLLECTION KIT’ printed on the front): 
 

 2 sterile, paper-wrapped swabs 
 1 small “SDPD Reference Mouth Swabs” envelope 
 1 smaller manila envelope 
 1 evidence seal 
 1 pair of large nitrile gloves 
 1 copy of ‘Instructions for the Collection of Reference Mouth Swabs’ 
 1 copy of the SDPD consent form 
 
Individual kits can be packaged together in large paper bags containing 20 kits. 

 
7.1.2 BIOLOGICAL STAIN COLLECTION KIT 

 
Keep 60-100 kits on hand at all times. 
 
Place the following items in a Biological Stain Collection Kit envelope (a manila envelope with ‘BIOLOGICAL 
STAIN EVIDENCE COLLECTION KIT’ printed on the front): 
 

 2 sterile, paper-wrapped swabs 
 1 tube containing sterile water 
 1 small ‘SDPD BIOLOGICAL EVIDENCE SAMPLE’ envelope  
 1 smaller manila envelope 
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 1 evidence seal 
 1 pair of large nitrile gloves 
 1 copy of ‘Instructions for the Collection of a Biological Stain’ 

 
7.1.3 VICTIM SEXUAL ASSAULT EXAMINATION KIT 

 
Keep 60-80 kits on hand at all times. 
 
Place the following items in a Victim San Diego Regional Sexual Assault Evidence Collection Kit envelope: 
 

 5 swube tubes 
 1 Pubic Hair Combings envelope with comb 
 1 Head Hair envelope with bindle 
 1 Left Fingernail Scrapings envelope with 2 fingernail swabs in a bindle 
 1 Right Fingernail Scrapings envelope with 2 fingernail swabs in a bindle 
 1 piece of tissue paper 
 1 evidence seal 
 1 victim label sheet (1 Cervical Swabs, 1 Vaginal Swabs, 1 External Genital Swabs, 1 Oral swabs, 1 Rectal 

Swabs sticker, 1 Left Breast Swabs, and 1 Right Breast Swabs sticker)  
 

7.1.4 SUSPECT SEXUAL ASSAULT EXAMINATION KIT 
 

Keep 40-60 kits on hand at all times. 
 
Place the following items in a Suspect San Diego Regional Sexual Assault Evidence Collection kit envelope:  
 

 5 swube tubes 
 1 Pubic Hair Combings envelope with comb 
 1 Head Hair envelope with bindle 
 1 Pubic Hair envelope with bindle 
 1 Left Finger scrapings envelope with 2 fingernail swabs in a bindle 
 1 Right Finger scrapings envelope with 2 fingernail swabs in a bindle 
 1 piece of tissue paper 
 1 evidence seal 
 1 suspect label sheet (1 Penile Swabs, 1 Scrotal Swabs, 1 Oral swabs, 1 Left hand fingers swab, and 1 right 

hand fingers swab stickers)  
 

7.1.5 PHYSIOLOGICAL SAMPLES KIT 
 

Keep 60-80 kits on hand at all times. 
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Place the following items in a Physiological Samples San Diego Regional Sexual Assault Evidence Collection 
Kit envelope: 

 

 2 grey-capped blood vials (Vacutainer®) each in a cigar tube 
 1 urine bottle with sodium fluoride 
 1 custody seal 
 1 evidence seal 
 
Blood vials and cigar tubes are provided by the Narcotics Unit. 

 
7.1.6 FETAL TISSUE COLLECTION KIT 

 
Prepared as needed. 
 
Place the following items in a manila envelope: 
 

 2 blue-capped 50mL conical vials (1 is a spare) 
 Evidence seals 
 Procedure for collecting aborted fetal material 
 1 pair of large nitrile gloves 

 
 
A cooler and ice pack will be provided to any investigators for transporting the fetal material to the Property 
Room.  Reference mouth swab collection kits should also be provided to investigators for the purpose of 
collecting samples from the mother and alleged father. 

 
7.2 ORDERING AND RECEIVING COMMERCIAL KITS 
 

7.2.1 Ordering procedure 
 

Requests for supplies, reagents, and DNA typing kits will be placed in the Supply Order Log (electronic file) 
located on the department network (G:\Laboratory\Annaliese\Ordering, Quotes, POs\Ordering Log 
AHD.xlsx). 
 
When orders are placed, the date ordered and the order confirmation number will be logged into the Supply 
Order Log. 

 
7.2.2 Receiving supplies 

 
The receipt of the supplies will be logged into the Supply Order Log.  The packing slip received with the 
supplies is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the 
laboratory. 
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7.2.3 Receiving chemicals 

 
The receipt of the chemicals will be logged into the Supply Order Log.  The packing slip received with the 
chemicals is initialed and dated then submitted to the Administrative Aide in charge of purchasing for the 
laboratory. 
 
A record of the chemicals on hand in the Forensic Biology Unit will be maintained.  Any new chemicals (i.e. 
not previously ordered/received) will require an MSDS to be on file in the Unit. 
 
Chemicals need to have the date and the initials of the receiver on the container. 
 
7.2.4 Receiving DNA kits 

 
The kits used for DNA extraction, quantification, and typing must all be recorded in the Kit Receipt Log upon 
receipt.  In general, the lot numbers of every component of the kit are recorded as well as the lot number of 
the kit.  Kit components may be stored in different locations and, thus, all kits components must be labeled 
with the lot number of the whole kit, or alternatively with an abbreviated kit ID # (e.g. IDP#-YY).   
 

7.2.4.1 QUANTIFILER KITS 
Record lot numbers of the PCR reaction mix, DNA standard, primer, and whole kit in the Kit Receipt Log.  
The PCR reaction mix should be labeled with the whole kit lot number and stored in the reagent 
refrigerator.  The remainder of the kit (in the original box) will be stored in the reagent freezer.  Place ‘Not 
QC’d, Do Not Use’ stickers on all kit components.  Replace with “QC OK” stickers once the quality control 
tests have been completed and reviewed. 

 
7.2.4.2 STR TYPING KITS 
Record lot numbers of all components of the kit and the whole kit lot number in the Kit Receipt Log.  The 
PCR reagents box should be labeled with the whole kit lot number and stored in the reagent refrigerator.  If 
AmpliTaq is part of the kit, it must be placed in a freezer holder with tube numbered (1 thru X), labeled 
with the whole kit lot number and stored in the reagent freezer.  The ladder will be labeled with the whole 
kit lot number and stored in the reagent refrigerator in the Amplification Room.  Place ‘Not QC’d, Do Not 
Use’ stickers on all kit components.  Replace with “QC OK” stickers once the quality control tests have been 
completed and reviewed. 

 
7.2.4.3 QIAGEN DNA INVESTIGATOR KITS (EZ1 or QiaSymphony) 
Record lot numbers of all kit components, except the buffers and proteinase K, and the whole kit in the Kit 
Receipt Log.  Discard the proteinase K and buffers.  Place ‘Not QC’d, Do Not Use’ stickers on all kits until 
quality control testing has been completed.  Replace with “QC OK” stickers once the quality control tests 
have been completed and reviewed. 
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